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Windows /i [ Code Composer (fijfk CC) & —NIhAETR K I m s 528 B AR 28,
EHRARZIERGS, T2 ARSI R TN T 2% . CC MhaedrEs

o, AATREXTIL T ThRE T, A IS A AR, AR RSERG DL — AN 741

-, ULHA WAl { F CC*C2000 KT A& i BV i R /7 e EA 0 LS I8 AT IX —FR 7o [
AT AT DR B RN 8, SR EERTIE . BT CAELLURUEN YR SOk
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1. AR TMS320LF2407 DSP SE46 T & R Ge iR F 45 84 o
2. T fi%# TMS320LF2407 DSP [ R (T & AR R o
3. ZEXJ{EH] CC’C2000 i TMS320LF2407 DSP #£)7-
ERAR
1. BB, T A e i 2
2. CC’C2000 {if LR~
9. SEEHRAESS]

TR 51 A 2EATTRI T CC1C2000 Gy — AN I H , JF HIEAT — 23R R, L
W R 2EAT DA AR AR ST K AT CC?C2000 S 7Y (1A FH 5 i

1. TRREHEE

FEBHUIRI, 7520k R 3L PC. XDP TEF4)7 B 88 X A5 AR I H bR R GE4% 0 R J7i
BT

* Fl JTAG HE & v 8P i B 422 1405 B0 S 20 il N S B AR b 11) T2 i J8 5 | TR 77 L2885

*FIE S PC EHLIFAT 1 5 1 HARAHIE

o J A3 Hs WU IR B HH A 5V 40l S IN PO 4di 65 IR 1. 2 F1 3. 4 1

¥ +5VDC/L5A RN 220V AR, FEL SR AR AME IRl CHXS
XDSPP i E. 4%

2. BRORREMFREE (Cedr, ATREEHD

£ Windows 2000 :{E R G2, %% CC4.10 FRAH CC A4 FE 2 DL % 11

3. PEBEHME Driver 23 (= WD)

3. MERBITHRRE

SFF NS AT RS RS B 1 H 2 ik CC LB 18 T AR EE R E 4T DSP 11 F2
PR BARERAE T 1ES WM .

4. CC’C2000 fryfajea i

CC’C2000 J& CC HtzLaiisy, M TAIEMEBINE, AIF RN LA A SRR T &
B TE IO SALRR TAEF 4. £ CC’C2000 H (1T 7 SO R A 2 H i DRk, 4
CC’C2000 [EE— g2t itm H, CAULHA A P k& s AT i) H AR R 4e CPU, il
TiH B & S50

(1 GUERRMIE (FEARSRR T, HAEY, AUl sEES s Wbs o)

FIF CC’C2000 A FH 7 A2 7 B2 A gt — AN T H “Project”, BRI H J5 vl LAAEYEAL
it SO RDA B () E SO IR H e A IR

L MRAE R PSR SO, filtn “ Citic2xx\myprojects\iwork 7
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38 “C:\tic2xx\c2000\tutorial\realtime” 10 {1 52 I B3 g 37 (K S e vp
*7F Windows &fi Xt “CC’C2000” Ebr, BRfE “FFah” SEHdikds “CC’C2000”,
BN 1.1 Fros i) CC’C2000 #4E St -

" fsdgo?xx/CPU_1 — C2XE Code Composer

File Edit ¥iew Froject Debug Frofiler Option GEL Tools Yindew Help

BE M 4200 AR m(ER | = EE 4R A
B Dizs—Aszembly
GEL fil,
..gr,oj;f‘ 0021 5C76
0022 E370 BOND 6639k, UNC

0024 95E9 SACL *0+,5,AR1

0025 BGEF7 LAR ARG, #0f7h

n0ze ES1S CC d2cbh,GT,C, Bl
0026 4ECF BIT =BR0-, 14,AR7
00ze 3675 SUB 75h.B

00zA 2E29 ADD 29h,14

0028 95D1 SACL =0-,5

nn>r TA”: MR #alfh

4 [

WELEIEEEL Py L

EEREGIER T

1.1 CC’C2000 # 1t it rhi
FEE 11 FRR R, PSR Ar A “Project>New” (JHH > W, HB—4
ikl 1.2 Froriy “Save New Project As” (A7 AT H ) XEHE, KEREELLRAF I H ST S A
Je CRIFTT AR i) TAFE H 3 work), 75 “3Cf4 7 SIBHER N —> B ST AE S04,
AR FORE I “syl” 1EAFATH QI B30T H ST I ORAF . IXI CC’C2000 23 H
SN2 “syl.mak” T H .

Save New Project As
BFED: [ vork =~ « @B efE-

Realtime. male

THEW: [ BEQ |
BFEED: [+ ma C| %
_m |

Kl 1.2 B H A7 HEAE
(2) e Ymi—ANa s S




FEK 1.1 B R, RS G4 “File>New>Source File” (304> > 5
RIS, TAEX N — Nl 1.3 FroRifseAR g 1, V5B d s gniE v 1,
EHIFREA T EoR “Untitledl”, FoRU5SCIE MR T4 -

" Untitledl

El

NEN — i
K13 SCORgnE N
AER 1.3 7, HHON R A IS 44, Stk S R dir 4 “File>Save As”
> 53470, BERIS B — A&l 1.4 Prosiscfd “ORaAEN 7 XHE.

B ?)X
BEED: [ work = cF E2-

[Z] maTw

[Z] RTVECTOR

El svl

IHE W sl {R1F (5) |

{RIF2ER (T): zzembly Source Filez [, azm) B

K 1.4 ORI IRTAE

TEE 1.4 W RORIY “SCRR 7 SRTERENFIA SO “syl”, I H e BAE8H 5100 H 3¢
AT H St fr—30 ARG mih “ORAT” FHI, XEHET IR, SCARZW AR T 110 b A o 46 il
THE SIS “syl” (LK 1.5 Prosfbmdihs) L g4 “asm” /177,

SRJGAESCAR Y o VN 0 — B RR e, A AT g 4R« I g AR ) SR Y
CC’C2000 J’E#s A KRBTk TAE, 205 Ja i A R 4 vl DU 9B 8l DOEPH S, B
A DU A Y G AR R A o T8 5 U S Lasm] @ T ASHE P 4l SOA ST g 2R SC
i, 28Rt mT L H Windwos B HH ) i g A B 5 AR A I mT DA 4R Al A S R AR
ERVE SO SniR A, XA A DOET B A AR TS T o AN, fRAER SO R A4 2
“asm”, JfHBIRAE A SCAKE A, BUERE CC*C2000 i .



CC’C2000 2’ a8 2 A7 B ok i) g i T e -

PR AR s T MR S0

G T 5 YRS R i

%l 1.1

ATEFPRARA s 8 AN BOL A, S8 I HTER A AR I 1) 7 oK B RO — A R SE I )
B R, EER TARYE, S Dk ag, U MREF WA A (H
U AR IR Zh 2k HL S RAE R SIMLIT D, Al eh AR AP NLR R BT ) i R

TR 5.

.include  "vector.h"
include  "F2407REGS.H"
.def _c_int0O,LED

LED .set 0200h
.bss DEYH,1
text

SYSINIT: RGBT
SETC INTM RN PSR}
CLRC  SXM
CLRC  OVM
CLRC CNF ; BO is configured as data space
LDP #SCSR1>>7 43 SCSR1 FTAE 1T
SPLK  #81FEH,SCSR1 ; CLKIN=6M,CLKOUT=24M
SPLK  #0E8H,WDCR ; Disable WDT
LDP #IMR>>7
SPLK #0h,IMR ;disable all interrupt
SPLK #OFFFFh,IFR ; clear all the interrupt flags of first level
LDP #MCRC>>7
LACL  MCRC
AND #OFBFFh ;IOPF2 L1243 ) 10 1
SACL  MCRC
LACL  PFDATDIR
OR #0400h Al PF2 T % O
AND #OFFFBH
SACL  PFDATDIR i AMfEfE 74HC273 5
LACL  MCRA
AND #OFFOOH
SACL MCRA ;IOPB[0-7]h—#% 1/0 B )fig
LACL  PBDATDIR
OR #OFFOOH
AND #OFFOOH ;IOPB[O-7] M BhRE IF 5 i 0
SACL  PBDATDIR
RET

CLOCK: s AR TAHC273 SRS kb (¥ TR P

LDP

#PFDATDIR>>7

SN gniE, A ES, BT ILE A B3
IR i C A R R SRR A TS C S AL



LACL  PFDATDIR
OR #0004H JPF2 18 sy HL P
SACL  PFDATDIR
RPT #10H
NOP SRR
LACL  PFDATDIR
AND #OFFFBH sPF2 1 AR HL P
SACL  PFDATDIR
RET
DELAY: ST AR
LDP #DEYH>>7
SPLK  OFFFFH,DEYH
LACL  DEYH
CLRC C
CON:
SUB #1
BCND  EXIT,NC
NOP
B CON
EXIT
RET
_c_int0
S FERTIIA D
CALL  SYSINIT T RGHIEA
LOOP1:
LDP #LED>>7
SPLK #0001h,LED 45 LED IWRAME R 1
LOOP:
LDP #PBDATDIR>>7
LACL  PBDATDIR ;i1 PBDATDIR [W{HI%5F ACC %1735
AND #OFFOOH AEEAE A R O
LDP #LED>>7
OR LED
LDP #PBDATDIR>>7
SACL  PBDATDIR O T R (MBI A R 1 27 A7 2%
CALL  CLOCK A BT Bk
LDP #LED>>7
LACL  LED
CLRC C ST HEALAT, DL RS A3 S
ROL asy 2 IVA
SACL  LED
CALL  DELAY G I
LDP #LED>>7



BIT LED,6 S LED A7 48058 JLAL S TC A

BCND  LOOP1,TC SR LED MO R B T 2, %) LED Ef It
B LOOP AR
NOP

PHANTOM RET

GISR1 RET
GISR2 RET
GISR3 RET
GISR4 RET
GISR5 RET
GISR6 RET

.end

R G CinlE 1.5 Fs), NiZMsEsdr4 “File>Save” (SUHF>1RA7) St
47 2] C:Mtic2xx\myprojects\work\syl asm #42 & SCHE 44 R o X TR IIEFRET, Wk —kA
RER N SEERIM T B iR, % AR AE, DUMEYE R — IR BBk EL TR ) TAE . fE KT
SOV NIRRT, AN HREAT AE A A — e SJ 15T, A e A DR i YR A/ T 0 T D
Fro

S(=1E

JiZFERFESCHLEC S8 AR | BOLEDAT BOfE 3 2o -
Ldnclude "wector.h”
Jdnclude  "FZ407REGS CH
def __int0O,LED
:.hes LED,1
:LED . usect ".datal",1
LED .set 0Z00h
hes DEYH, 1
text
Y INIT: R TIERF
SETC INTM ; 32 1] A o
CLEC S
CLEC 0%
CLEC CHF : BQ is CDEEE@EEEE E:J
s s ca e o T A i a '_ﬂ

K15 USRS e g 4 2 1
(3) H3ca g H

T 00 H SO I E B B, WO E R R R AR “syl.mak” (I H 3¢
b, AR P RGEEAT T I 75 R P i SO S AR H S, RS TR ik
— MR TR AR SO SkoCpE B 2 S P BESCRE N TR RS, 4
Y/ gmiE” ORI CRERE /AL, AN L.

R 11 PR AR, ks dr 4 “Project>0pen” (I H >4T7F), HiR4E4H
[} “Project Open” XHAHE, 1EFECAFITH SCHEPT AR SO ISR IR S0/ Canls] 1.6 o),
SR L FESE L fr 4 “Project™> Add Files To Project” (3l H > ScE#05 H), B4
Kl 1.7 o) “Add Files to Project” XJUGHE, 4R 5K AT H 22 H 1% .asm 125 S .cmd
FERE A A ORI —AS “rts2xx lib” [PESCHF R —— Bz H v, AEBOAE LT, %



A AT BATE “Ciltic2xx\c2000\cgtools\.lib” H s ik 2 o X T.h Sk SCAFIFERE 7 A “include”
SUHRISCHE, REER—AHRF, TREHESAsIN . TREHESA R
ANILE RIS

Froject Open @

EHIEE O [ work [ £ EF-
Realtime. mals
syl.mal':

iAW I3 @) |

HHEE D [+ max = e

K 1.6 T B SCAFIE R TEAE

Add Failes to FProject @
EHIEE D) | work | £F Ef-

[Z] matw
[Z] RTVECTOR

[% =¥l

IOHE |53r1 T H @) |

prae e MR - Source Filez [k ok % ok Bl

17 ASINSCAER TR AR
(4) SFIH I

— Hgwik T 304, Project B 4 AR 21 45 4 S 7 it H AL 25 IR SCAR G &R, anfs] 1.8
JioR o AU TAEAH SRR SCA R A — e, B — AN LS e AN s A Hash, 1 HIJs
ST A IRAE— AN AN N o T H BB 1, w] Lo 7 (SR I E P )
SR I B SO

)33 CC’C2000 Ji7, 43 HANR R HITHEBE H . WREA Bk M, o Uk
My 4 “View>Project” CUEE>T0 H ) {2 3#d . H BR8N T “Project” FF&E£ “Open
project”, HAE VAU 1.9 Fros, ARPsLHE CanlE 1.6 BIXTEHE,  FH AT AR [H 6 5 ik e
FIIFI0H SO, ARG nT R s S I SO “ 47 FF5 R Bon & S0 CRAARERAES DL
KA.



& Files

+- [0 GEL files

SRS
- =¥l mak
£2407. emd

- D Include
FZ40TREGS. H EH0E.

=[] Libraries } 3"’;L _— |
rt=Exx. 1ib Eﬂ

=0 Souree " er—
=xl. azm . '_L__ Dacking

Eide

Floek 1o Ban Riades

/4]
K 1.8 HERE Bl 1.9 SCPHEAET L
(5) Zwidiits

JA8)) CC*C2000 1% J 1264 X0 V1 Gt 155 75 VR AR e AT G PR ) 050 2 0, e Al F i 0732
& FE L BRI R, ek a4 “Project>0pen” (I H >4T7F), LML E T
BRI H SO, AR5 FRIE S S A “Project™ Rebuild All” (I H > J1- 4 4 PEFIBERE T
HIXAD, CC'C2000 F4 1F 2 1 I 2 Gt 16 s AR AR 100 H SO “syl.mak” A5 BN HU6 SC
P “sylasm” gt A p H bR SO “sylobj”, X2 HEL—AN i 1.10 Frzsf “Build” (41
A w i, HAEEeE AT AR URIRAT: “Build Complete” (G520, WHRA S,
B AT RN R AN BOREON . HLSE, IXOR R S R H N — bR, DB RIS T

fif# CC*C2000 1 ZnZim 12645 42 ] 735 BA FRAN T AT FRA R ) (RIS DR AN 5 B B E AL

dsplnk sv1.mak j
TM3320C1z-Cln C2xx-Cox COFF Linker Version 7.00
Copyright (o) 1987-1999 Tezas Instruments Incorporated

Build Complete,

1 Errors, 0 Warnings. -

[ 121211 Buila / L/ ﬂJ
DSE HALTED For Help, press Fl In 13, Col T oM

K110 BUEEEERE R ORI

F PR RGN 1A R IS B RN [P 2 J5URE 7 th 2 B FME L, AR5 K Bk 7 v d g gk
ITHPE. IR PEIERE, FBEHE NS4 “sylout” I m] $hAT SO PR I
Bl 1.1 Frosiy “Build” (BIED & H, e AT S URRAT: “BAHR.” 2, RATHE L
T—ATLLEE CC’C2000 F£55 T F XDS510 A1 Hgs BT IR0 . SeEMIH

L

dsplnk svl.mak
S320C1x-C22-C2xx-Cox COFF Linker YVersion 7.00
Copyright (o) 1987-1999 Texas Instruments Incorporated

Build Complete,
0 Errors, 0 Warnings.

[ <> ¥ Buita / []4

DSF HALTED For Help, presz Fi Ln 13, Col & nm

K111 g R E D ORI

L



XTI E, — S5, 7EE H CC’C2000 WRIAEENT, R4 HsE “WiH X
PE7 ORAFAE “ wks” ST o T T4 TAE SO VR R e W 5 B R R A7, i HI S dn & “File
>Save” RIA[{RFEF] “syl.asm” SCfFH,

G RRERE I 2 5, T B A B “sylout” nl AT SO B S i b S5 A REXT
P AT IR B DRI, 7ER L1 Fosi Ay, PR a4 “File>Load Program” (¢
P> B R ), B — & 1.12 B (#“ Load Program % i HE , 48 J5 45 il #4477 111 sy.out”
SO R EEISEIO AR o SO NS, T SO T A 2 R

Load Program E]
HHEE 1) |lf}wnrk ﬂ EF '
B % REALTINE
ki R
F__h%
=
k= R
AR
i _k SERE
I ] | e |
IrfR2ER (T |* out [Coff) ﬂ HEiH
FERD (D

K112 FRIFREEEHE
TR ARSI P A AR X A BRSO H , ZERITE S48 BRSO 44 FIE SO
Y IRFE— 2
(6) AT

FEf Pt e e AT B MRE Y, R RENE IR W 18T, A EIERAIR, 2
FEVCTHR, Sk CATLUEAR B ERAE A, TV SEALN AR oS il LR R B2 i &

B, R Ae S HER A & AP R TR, R RR LI TN B TR, AEAE.

CC’C2000 AR BE I RER 3, W LAYE C B 5 iR, Wl LB gwiE & i, JIf
Pt T 2RI TR 07 NER R TF Bt A LR LR &E80817. B WEE .
BOPIEAT SEISAT BB W MU AT A . 1 THCKG I I FT T 45 2 (191 7 B YR N Hb A 43 45 Pl ik
FB AT 7

<EBHEAT

EE 1.1 Pos S b, SRR MR AT H o BRI RS R4 “ Debug
>Reset DSP” G >DSP &7, sk diihi THEA: FiGesl, i DSP &4y, R)GkFtseim

fir% “Debug>Run” CGIRX>FEE1T), siFH#%5) Fs i, st ok TR L 2 bR
Hl, BSREFHEANSENIZITRE . B LR ar S, FAVEIPE A WA AT SOV,



R EAEE BT, T LI WA TR F 0 2 o b 5 SO e R,
RAL N R W R P 1EAEIEAT

H 11K BURE P 45 K JCBRAE AP 4l b, ARARZE R P I AT v] e T A i = s
Jl, BFIERESE A4 “Debug>Halt” G >1{510), sig 48— NAE L “Shitf +Fs”
HEH. FERY, THEMBEEIR, RURP TSI, JERNIHE B R P —17 b

RS T IR, RSP T BRI L, HAE U9 TR G, R
AEERA T FH— R ol W, RAHZXMIRATFB, AMET LB TP eI RE, WAE
T HIRE P IS T R o X T IR A S I B (R IX B IR 45 i B RE Y, IESHEAT )7 A 2
—FIRA R T B Bk, FFZEE— P ER R R e AT B

B

FRAE e R (384T T 22, AT LLYE CC’C2000 S - [AII BT i % 6 MAES M
S o T M EE R P AE G AN AT A A N2, AT o B EDULHb 23 7 R 1 1Y) 32 4 D) RE IS
FPRo,  BEmIA BRI H H .

S R P YR R IX AN LU R, b I B A7 A7 48 Bk T ACCL STO. ST1 il PC
REFEEZAh, UTT S — MR RN, fEWEA R AR =LA, (P frd it
ZAR ST IS .

FATAT AR XA G DR BEE S A o B T L AW MNERE A 24, LU
Ve RIS T fPftas i . CPU Aifrastd . WEE M.

B ME T s R BRI i e AR P AR s R A 25 e S i prh, H— & ke
SLARRAR TR TR ER, T bR RV G 1 O R T VAR v BT A, P R — O R RTEO B R
TGN FHVE S WL 5% o

FEGAR T ] AR I N 2 TR VA S W 5% .

CPU Zif7#s % 1. H s “CPU Register” 1 “Status Register” WM&, fAidifHN
(e ] LIS RIS B CPU Z3 A4 & NIRRT B AR B VA FHVE S LI 5% e

ML 1 MR R AR . C KRR, bR F A8 0E. £/ 1.1 PRt
I b, CKRURAR P SR o i 1, RS R4 “View>Watch Window” (F1 & > %2
WD, a2 A% D IAE CC’C2000 % HF R, Wik 1.13 Fion. %% H AR ER
PRk FER AR, FFAdn MIAF A4 1R P 25



" f=dgo?xx/CPU_1 - C2XX Code Composer— syl.mak
File Edit ¥iew Froject Debug Frofiler QOption GEL Tools Hindow Help

IR A RRWM[ SR s EE 4R A

Fre CFEX
#-GEL files SIS ELE R AULEDIT ROfR A B
=0 Project .include "vector.h"
=g syl el .inglude  "F2407REGE.H"
<[ £2407. emd def _c_int0,LED
++( Include 5 .hss LED, 1
=] Libraries ;LED.usect ".datal", 1
B rtezexlib | fIED L set 0200kh
=0 R bss DEYH, 1
[ sl asm
text
SYSINIT: s ROAIELFIEF
SETC INTH » 3% ] B O
OLRC Exal)
OLRC B
CLRC CHF ; BO 1s configured as data space

LDFP #SCSR1>»7 G EVISSCSRIETTERI T

SPLK #B1FEH,SCSR1; CLEIMN=6M,CLEOUT=24M
SPLK #0EGH,WDCR  : Disabls WDT
LDP HIMR>>7

&3 Dis—Assembly <3>

0000 1458 LACC
0001 CHOAE MPY

Insert Hew Expression

0002 003A LAR ARD, 3ah Remove Current Expression
0003 96A0 SACL *+,6 Refresh Watch Window
0004 2511 ADD 11h.5 Contimems Refresh
0005 OO0EOD LAR ARD, *0+

0006 5085 MPYA *
= 0007 0A2C SUBC 2ch

Expand hs Array
Help

AEE s AR 292 (BC RN e KEE®

B4 0008 8101 3AR AR1,1h Lo Dodk
w #llow Docking

PC = 0000 ARO = 0000 1IMR = 9017 ~ Hide I AFP = BRS ARB = AR7

ACC = OOFFFFO0 AR1 = FFFF IFR = 0000 B3 Float In Hain Hinder o7 =0 CNF =0
PREG = FF3(C3965 ARZ? = 7FFD GREG = 0001 OVM = 1 TC = 1

REG = 6277 &R3I = 0065 INTHM = O SEM =0

5T0 = ACSC &R4 = FFFF DE = 05C c =1

5T1 = EBEC AR5 = 722D = - HF =0
RPTC = F23D ARG = FEFEB v | TR waten [« _,|—| PM = D
DSE HALTED | For Help, press Fl a1, Colos [ mm[

Kl 1.13  CC’C2000 % 1R M 8% I
H T AR AR, )R] DU AR S B AR A T W AL
AN AR R AR DS s b s BROPR A B, 3 B RS o, BB EL (1) “ Insert New
Expression”, Wi 1.13 fizc. SEAPTIEPERIK 1.14  “Watch Add Expression” (s 175 5%
WHE), TESCAR P BEANFT SRR RS, ARG AT “OK” $24l, RInl 7 g H 5 i
— MRS AR L, WA, H AR 7 RIe ] DAE SR IR N 2 AN & 7R 1%
S ] DA B LU (4 SR AR s () B il CHRERD . 75 44 T

¥atch Add Ezpression

ixpression: I

0K |  Cancel | Help |

Kl 114 7R IR f 0 1S AE
TWHE AR TR 1 bR — SRk T R A T B R s, ik
bR AT, ZE9RH IR R b ¢ “Remove Current Expression” RIT]
WA I AZ BB PE AN IR B IR AE 7 1 SCAR U N B 4, MRS & 1 L8
ANz L AR T R A R M, TR R AT xS
A bk L BRSO T HER], A SRAR O WAk o, R AR B AR I
Ji IR — AN 5 R — A KRR T BE e W IR 3R 7m 7 REAN ARG 0 B OG & fnse

1.1 fii. R11 BRRIER TR
FRE fodft
D it
E SRR
F LI A




R WAy
J\EH
TErF 5
ASCI 745 (714

O|Cc|O|X

BPIEAT & — PRI P is AT R A RO5 %, T HLRENS KN WS B 1) s AT IR A .
BEf N — IR EE R a2, BRI SBAT — 4454, JF HAZZI S8 CC’C2000 s i b4 8¢
&P SRS B UUSCRES P SR E R, W A SRz da S AT 25 R . BARERAE Ty
PRI

TEE 1.1 Frosi St b, KRR e s & VR a0 s B, H AT ik 7 kA8 DSP 54 .
IR JGILEFE Hfi % Debug>Step Into G >FPE4T77 50, B 4% — ML L Fe B,

Wit e TR O R, B AR BRI . — s ©F ek
HIRII, T DU B0L5E B ot DUAS 2 (2 4 ek B, O LS o 1 8 ST J I S
AT ST BRI T, AL B T AR M5 TR 17 LI AT
FRFRIE TR, T M 3E 177 3 5 SIS 7 SO L 02 U L ) T A
CEHEIEAT IR
ANEAT 7 A (R SE3E 177 SIS RE 1 3 B ATt R SR AT 7 SR
(A A T R R B3 o B A, TR 1k S T S i
eV L1 BRI AR LS B U AR 1, kL DSP AR, AR
PR 4 Debug™>Animate (A >z 7750, L& — TR L Fod, 503

sk RAE A 2 BIbRAGHL, BT SR P BEA S EEATIRAS o [F) I N R 25 A7 4 A

R, ROk, AR, fily o 2T,

* BEE W RT3

FE B P IR, AT DL S I2 AT I8 £ fa] ) sl LB RO RE 3 v B, T2
FDIEAT IR LSS % A B A KRR 3 P B XAl T LR IE S AT U7 SN 838477 5
PIEE AR A o B, AT A BT DR B S s oK, IR H 174
AR, DUE M )45 A o XL n] T AR et e 5 (K47 B BT RSBt mT A
Y, WCEW R RIS AT R o Rl RO k.

— AP AR B E W T AR 1.1 B S el R 2 i e O R e L

PSR R ICHE 4 5 B A FOBTRR P AOAT IR, it O PR Lo 0 LR, LN, 2%
AT 5, RoRBE e b L PIbRI%HL,  HO T BB R s

% L B A O AT PRI, 1 LR HESEIE 4777 2 Ak DSP 42z, 8 1 &
BB R SEIZ AT, B0 1 1 AN A B 1l AEAT 45 SN2 IR, P il 2
FAAERE Pk aizty, HEE E5 2 MW ags, 555 KT &

Sebr b, HOH R AT ZH K 5 AR TBOR S, DUB R AR AR . SeEl
Al DhReAT Z M sk, AUSERALH RZAAT R T CCS (LL CC4.10 A H1D [FIBEA L,



AVFZ I DIREE T3 B A A TR B S S 2 4 L824 .

Ky — HHES RIS

—. ERULE

Y DSP N R Z, 844K T DSP RGN A, i TFRFIEN, Brdsn
A R SAEAE— S8 8, R IO R A T R, I RS SR A AN A T
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VERE AR -

(D JIv R S AE A I 1) e SCCAF “vectors.asm”

title "vectors.asm"
ref _c_int0, _nothing
.sect ".vectors"
reset: b _c_int0
intl: b _nothing
int2: b _nothing
int3: b _nothing
int4: b _nothing
int5: b _nothing
int6: b _nothing

2 TR



1 EFR T SEERAR BT 8 A LED IR B
#include "register.h"
initial ()

{

}

asm(" setc SXM");
asm(" clrc OVM");
asm(" clrc CNF");
asm(" setc INTM");
*SCSR1=0x81FE;
*WDCR=0x0ES8;

*IMR=0x0000;
*|IFR=0XOFFFF;
*MCRA=*MCRA&OXOFF;

*PBDATDIR=*PBDATDIR|0X0FF00;
*MCRC=*MCRC&0X0FBFF;
*PBDATDIR=*PBDATDIR&0x0FF00;
*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&O0X0FFFB;

Il WA T REY

I AR SR

11 B nasH 45 B I i

11 BO % C . A 40 A7 i 4 1)

1125 BT A

/I CLKIN=6M, CLKOUT=4*CLKIN=24M

Il RAEREE T, [H2% SCSR2 Hf¥) WDOVERRIDE
11 B WD Ry 7 S A7 JE B A 1, AT DA

Il AT BT

1125 BT A

I ERRAFR Wb, " 13 0"

/1 1OPB i g &y — M) 1/0 ThiE, TMS320LF240x )
Il B340 8 7, MCRA i 16 A7 pkdzH] T 10PA,
/I F1 1OPB {1 # &

11'OPB iy I B¢ Ay th 77 2

/13t 1OPF2 st S 4 — % 1/0 3 O

I JEK A LED 4T

I1oPF2 W& A7, H IOPF2=1

I/ TOPF2=0

11 VL B8R N ik, A LED 4xdlid K

I ERF
main()

{

int led;
inti, k;
initial();
while(1)
{

I8 SN i AR i
I e e — S AR R
Il RE0)A1k

for(led=0x0080, i=0; i<8; led=led>>1, i++)

{
*PBDATDIR=*PBDATDIR&0x0FF00;

*PBDATDIR=*PBDATDIR|led;
*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&O0X0FFFB;

for(k=0; k<OxOffff; k++)
k:k;
}

I 2B 10PB FIAA

I FEE BRI ERSS 10PB i 1
IMoPF2 W& A7, H IOPF2=1
I1OPF2=0, XM fJiEm)4s— Ak,
Il 4§ LED |75 10PB 3 1 FI{E

18 TARAE BRI R), 25— 52 IR [A) ) SE I



I B AT R 55
void interrupt nothing( )

{
return;

}

by A g

VO Hi A Rt GBITD

; (D FREF

IOSFT_REG  .usect ".data0",1 B BRI A AR
include  "F2407REGS.H" s SRS

; .include "vector.h"
.def _c_int0
text

_c_int0: AT ERRFIAD
CALL SYSINIT TR BRI TR T
LDP #DP_PF2 ;517 7080h~7100h [X.
LACL  MCRA
AND #000FFH ;IOPB [IiC &}y —# 110 ThE
SACL  MCRA
LACL  MCRC
AND #OFBFFH ;IOPF2 FE h—f% 1/0 Lhifig
SACL  MCRC
LACL  PBDATDIR
OR #OFFOOH ;IOPB [ & iyt 75 3
SACL  PBDATDIR
LDP #5H ;3817 0280h~0300h [X
SPLK #01H,I0SFT_REG ;45 B n R IR HI{E

LOOP: LDP #DP_PF2
LACL  PFDATDIR
OR #0404H ;IOPF2 Bk kit 7720, H I0PF2=1
SACL  PFDATDIR JT 74HC273 Jiikfs 5
LDP #5H

LACL  IOSFT_REG

LDP #DP_PF2

OR #0OFFOOH

SACL PBDATDIR AR ORI E RS 10PB H

LACL  PFDATDIR
AND #OFFFBH IOPF2=0 (W iZflifit Bor)
SACL PFDATDIR e TAHC273 Kikf=%



CALL
LDP
LACL
SFL
SACL
BIT
BCND
B

LOOP1: LDP
SPLK

WAIT: NOP
B

DELAY
#5H
IOSFT_REG

IOSFT_REG
IOSFT_REGBIT8
LOOP1,TC
WAIT

#5H
#01H,10SFT_REG

LOOP

; (2 ARGy

SYSINIT:
SETC
CLRC
CLRC
CLRC
LDP
SPLK
SPLK
LDP
SPLK
SPLK
RET

; (D A RE IR

DELAY:
MAR
LAR
LAR

DELAY1: SBRK
NOP
CMPR
BCND
RET

—. KR

INTM

SXM

OoVM

CNF

#OEOH
#81FEH,SCSR1
#0E8H,WDCR
#0

#0000H,IMR
#OFFFFH,IFR

*,AR4

AR4 #0FFFEH
ARO,#00H

#1

00
DELAY1,NTC

L5 Y

SR IE N R

SRATIEIAE R C RS 5 8 ROt —

SUATE IR 58— ) 7= Al Tt )

;B0 WlHC A e A7 A 1)

;CLKIN=6 M,CLKOUT=24 M
AMitifiE WDT

At
A P T

s g Er

FEFE RS, 8 DR R P AT R B AN . R 41, 44
Pkt Ky~Ky 73 D0 . TMS320LF2407 5 1 (175 IOPF3~I0PF4 124 1/O i ¥4, 8 H
RN M LED1~l LEDS @ik SW-DIP8 k15T 1 74HC273 4AE 8% 15 B 70 5l %
TMS320LF2407 & 1y (1) 5| IOPFO~1OPF7 {24 1/O ity 11 I i Hh o ASSIZER AN A FH — 4% 1/O 5 I,
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—. ERHKM
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Ii. ERSHERFFE

MR, Wt MZBETH RS, SRR AR, 8 N T EIAE, ot
HASIWILAME Y 0, BP = HEHI%L% 00000000B; 4% K1 #EiF, THE#s M 1, ke
P LEDO sz, Ry —idbHi|£k¥ 000000018, #RJGAATFHck; P kd% T KL B, s
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(L I 95 R AN R0 e T 1) 8 SO A “vectors.asm” [T RT. FEIX BUS BT A GIFE T, WA H R

YR, vectors.asm #SEAH AT

(2  EEF
VERE AR -
#include "register.h"
int m=0x0001;
initial()
{

asm(" setc  SXM™);

asm(" clrc OVM");



asm(" clrc CNF");

*SCSR1=0x81FE;

*WDCR=0x0ES;

*IMR=0x0000;

*IFR=0x0FFFF;
*MCRA=*MCRA&OX0FF;
*PFDATDIR=*PFDATDIR|0x0400;
*PBDATDIR=*PBDATDIR|0x0FFOO0;
*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&OXFFFB;

void inline disable()

{
asm(" setc INTM™);

int keyscan()

{
int k,j;
k=*PFDATDIR&0x0008;
if(k==0x0008)
k=0;
else

for(j=30000;j>0;j--)

=i
k=*PFDATDIR&0x0008;
if(k==0x0008)

k=0;

else

k=1,

}

return(k);

int keyserve()

{
intk;



k=*PFDATDIR&0x0008;

if(k==0x0000)

*PBDATDIR=(*PBDATDIR&OXFF00)+m++;

else

*PBDATDIR=*PBDATDIR,;
*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&OXFFFB;

}

main()

{
disable();
initial();
while(1)
{
inti;
i=0;
i=keyscan();
if(i==1)
keyserve();
}

}

void interrupt nothing()

{

".b20",1
".b20",1
".b20",7

return;
}
H{BE TP e R g
RS RO TR R AR
st0_temp .usect
stl_temp .usect
context .usect
STACK .usect

IOSFT_REG .usect
10_COUNT .usect

10_DATA .usect
LEDXS .usect
LEDFLAG .usect
K1FLAG .usect
KEYDATA .usect
DP_USER .set
.include

".stack",40

".data0",1
".data0",1
".data0",1
".data0",1
".data0",1
".data0",1
".data0",1
5
"F2407REGS.H"

;60

;62-68

R B A B A7 A
AT HE A7 A

SO I HHis 22 X
;LED /R #dh
;LED BRbr& 17 a4
KL bRk 7 fras
AR AT T A7 38

VPSS Es



.def _c_int0
) AL ) R

sect " vectors" B S B
RSVECT B _c_int0 PMO Reset Vector 1
INT1 B PHANTOM ;PM 2 Intlevel 1 4
INT2 B GISR2 PM 4 Intlevel 2 5
INT3 B PHANTOM ;PM 6 Int level 3 6
INT4 B PHANTOM ;PM 8 Int level 4 7
INTS B PHANTOM PMA Intlevel 5 8
INT6 B PHANTOM PM C Int level 6 9
RESERVED B PHANTOM ;PME (Analysis Int) 10
SW_INT8 B PHANTOM ;PM 10 User S/W int —
SW_INT9 B PHANTOM ; PM 12 User S/W int -
SW_INT10 B PHANTOM ; PM 14 User S/W int -
SW_INT11 B PHANTOM ; PM 16 User S/W int -
SW_INT12 B PHANTOM ; PM 18  User S/W int -
SW_INT13 B PHANTOM ;PM 1A User S/W int -
SW_INT14 B PHANTOM ;PM1C User S/W int -
SW_INT15 B PHANTOM ;PM1E  User S/W int -
SW_INT16 B PHANTOM ; PM 20 User S/W int -
TRAP B PHANTOM ; PM 22 Trap vector -
NMI B PHANTOM ; PM 24 Non maskable Int3
EMU_TRAP B PHANTOM ; PM 26 Emulator Trap2
SW_INT20 B PHANTOM ; PM 28 User S/W int -
SW_INT21 B PHANTOM ; PM 2A User S/W int -
SW_INT22 B PHANTOM ; PM2C  User S/W int -
SW_INT23 B PHANTOM ; PM2E  User S/W int -
SW_INT24 B PHANTOM ; PM 30  User S/W int -
SW_INT25 B PHANTOM ; PM 32 User S/W int -
SW_INT26 B PHANTOM ; PM 34 User S/W int -
SW_INT27 B PHANTOM ; PM 36 User S/W int -
SW_INT28 B PHANTOM ; PM 38 User S/W int -
SW_INT29 B PHANTOM ; PM 3A  User S/W int -
SW_INT30 B PHANTOM ;PM3C  User S/W int -
SW_INT31 B PHANTOM ;PM3E  User S/W int—
s ) BN I SE X pvecs

sect " pvecs" s F Il = B
PVECTORS B PHANTOM SR B I B bl A% £-0000h

B PHANTOM SR B I LU A% 5-0001h

B PHANTOM ; PREA ) R R

B PHANTOM ; PREA ) L R

B PHANTOM s PR B 1) A R S

B PHANTOM s PR B ) R S



0 W 0 W W W 0 W W 0 0 W W 0 W ™ 0 W W W 0 W ™ 0 0 W W 0 W ™ 0 O W W 0 W ™ 0 0 W W 0 W @

PHANTOM o B 1) R (W A B -05

PHANTOM ; SCI_RX_ISR; &8 I &t il #
PHANTOM ;SCLTX ISR ; 1R &bt &
PHANTOM o AR R B A
PHANTOM o AR ) B A
PHANTOM i PRE ) B b kRS -0A
PHANTOM s R BRI S RS
PHANTOM s AR BE If) h fn AS
PHANTOM s R BE If) hk fn AS
PHANTOM o AR BE If) hE fn AS
PHANTOM R = H T B B R 2 A
PHANTOM ;R ) S s 2- 10
PHANTOM s AR BE If) hk fn AS
PHANTOM s R B 1) kRS
PHANTOM s R B 1) Sk RS
PHANTOM s R BRI kRS
PHANTOM ;AR ) S s - 15
PHANTOM o R B ) b RS
PHANTOM o R B ) R RS
PHANTOM R R H T B 01 R (2 A
PHANTOM s R B ) Rk RS
PHANTOM ;AR ) Bk RS 2 1A
PHANTOM s DR BE ) Rk RS
PHANTOM s DR BE ) bk RS
PHANTOM =2 H T B 01 R 2 A
PHANTOM s PR B ) bk RS
PHANTOM =2 H B 01 R (2 A
PHANTOM s AR ) Rk R s & -2
PHANTOM o 3= H T B 01 R 2 A
PHANTOM s PR BE ) b RS
PHANTOM s PR BE ) b RS
PHANTOM o (=2 H T B 01 R A
PHANTOM i PR BE 1) Sk fh A% 425
PHANTOM ;PR 7 bk B F:-0026h
T1GP_ISR o REY i Bk R A BE-0027h - TIPINT Hikr
PHANTOM ;PR 7 bk i B =:-0028h
PHANTOM o AR R B A
PHANTOM i PRE ) bR S e -2A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR B A
PHANTOM ; pvector addr offset 0x02f - T3PINT

PHANTOM PR E ) = kR RS = -30



B PHANTOM o AR B A
B PHANTOM ;AR B A
B PHANTOM o AR A B A
B PHANTOM o AR R B A
B PHANTOM i PR ) bk A% B35
B PHANTOM o AR A B A
B PHANTOM s R BRI S RS
B PHANTOM s AR BE If) h fn AS
B PHANTOM s R BE If) hk fn AS
B PHANTOM s AR ) Rk S 2 -3A
B PHANTOM s R BRI R RS
B PHANTOM s R B 1) Sk fn RS
B PHANTOM s AR BE If) hk fn AS
B PHANTOM s R B 1) kRS
B PHANTOM o R B 1) Bk g A% BE-3F
B PHANTOM ; CANMBX_ISR; {8 [ & htik s =
B PHANTOM SPR B 7] S bk (A 5E-0041h
D (2) TRFE
text
c_int0
CALL SYSINIT TR BRI R T
CALL  KEYLEDINIT MBS LED WAL
LDP #DP_USER ;4817 0280h~0300h [X.
SPLK #01H,I0SFT_REG  ;Zif7-as FldR EWI LA 1L
SPLK  #00H,I0_COUNT
SPLK  #001H,10_DATA
SPLK  #001H,LEDXS
SPLK  #00H,LEDFLAG :LEDFLAG.0=1 %/ K1,K2,K3 #i
;LEDFLAG.0=0 %/~ K4 % F
SPLK  #01H,KIFLAG
CLRC  INTM PAwSR
LOOP: CALL  KEY SRR e, R 4 e
LDP #DP_USER
BIT LEDFLAG,15
BCND  LEDBD1,TC
LACL  10_COUNT
SUB #03E8H
BCND  WAIT,LEQ ) 10 s ZEIN 3 5
LEDBD1: SPLK  #00H,IO_COUNT
LDP #DP_PF2
LACL  PFDATDIR
OR #0404H :IOPF2=1
SACL  PFDATDIR FF 74HC273 Fik(E S



LDP #DP_USER
LACL LEDXS

OR #OFFOOH ;IOPB [0 44t 773X

LDP #DP_PF2

SACL PBDATDIR AR EL R E RS 10PB H
LACL  PFDATDIR

AND #OFFFBH :I0PF2=0

SACL  PFDATDIR K TAHC273 k(55

LDP #DP_USER

BIT LEDFLAG,15

BCND LEDBD2,TC
LACL LEDXS
SFL

SACL LEDXS
LACL IOSFT_REG

SFL
SACL  IOSFT_REG
BIT IOSFT_REGBIT8  ;HETEIFE—IK
BCND  LOOP1,TC
B WAIT
LOOP1: LDP #DP_USER
SPLK #01H,IOSFT_REG ;IR ¥I{E
LEDBD2: LACL  10_DATA
SACL  LEDXS
WAIT: NOP
B LOOP

; (3) RGP

SYSINIT:
SETC INTM
CLRC  SXM
CLRC OVM
CLRC  CNF ;BO DX g i Bk HE A )
LDP #OEOH ;#5171 7000h~7080h [X.
SPLK  #81FEH,SCSR1 IHed 4 {5545, CLKIN=6 M,CLKOUT=24 M
SPLK #0E8H,WDCR Al fiE WDT
LDP #0
SPLK #02H,IMR AERE T BT SE4 INT2
SPLK  #OFFFFh,IFR A TR S
LDP #DP_EVA ;4517 7400h~7480h [X.

SPLK #80H,EVAIMRA AERE TIPINT ik

SPLK  #OFFFFh,EVAIFRA ;i EVA Wiz

SPLK  #0,GPTCONA

SPLK #OEAGH,T1PR AdE 28 4F 10 ms AR Pk



SPLK
SPLK
RET

#0,TICNT

#0164CH,T1CON

BRI E I 4% 1

s (4 BRI A MR R

KEYLEDINIT:
LDP #DP_PF2
LACL  MCRC
AND #083FFH ;IOPF2,10PF[3~6] P& A —MH /O [
SACL  MCRC
LACL  MCRA
AND #000FFH ;IOPB[0~7] At & A —f# 1/0 [
SACL  MCRA
LACL  PFDATDIR
OR #0400H JIOPF2 Jy#ir i 77 5%
AND #08787H ;IOPF[3~6] MHIA T
SACL  PFDATDIR
LACL  PBDATDIR
OR #OFFOOH :1OPB[0~7] #7573k
SACL  PBDATDIR
RET
; (5) B
KEY:
CALL  READKEY SR
LACL  KEYDATA
BCND  KEYRETEQ :ACC=0?
CALL  KEYDELAY SREI W )
CALL  READKEY PR — IR
LACL  KEYDATA
BCND  KEYRETEQ
LDP #DP_USER FUWT B L
BIT KEYDATA,15
BCND  KEYRET,NTC
CALL K1 R
B KEYRET
KEYRET: LACL  KEYDATA
AND #OFFFOH T SR B A A 2R
SACL  KEYDATA
RET
; (6) TR
READKEY:
LDP #DP_PF2



LACL  PFDATDIR U B {E PFDATDIR.3~PFDATDIR.6
RPT #2
SFR At 347
OR #OFFFOH BElR 4 0 CFHE 4 AMED
CMPL
LDP #DP_USER
SACL  KEYDATA AT
RET
0 (7 HRAEZER 30mS 3
KEYDELAY:
LACC #6000
KEYD1: SUB #1
RPT #80
NOP
BCND  KEYD1,NEQ
RET
; (8) HET R
K1: TR R
READKI: CALL  KEYDELAY
CALL  READKEY
LDP #DP_USER W KL TS
BIT KEYDATA,15
BCND  READKI,TC
SPLK  #01,LEDFLAG ;] LED 2R hrats, B LED X A — AN SOl
LACL  10_DATA
ADD #1
SACL  IO_DATA
RET
(9 HiFE T
GISR2: ARSEZ INT2 Hhillr A0
R IL
LDP #0 ; IRAEHLAS BN
SST #0, st0_temp ¥ [ 3hS-4k DP-0
SST #1, st1_temp  IRAPIRAS A 4725 3 B2 DARAM.
SACL  context ; AR1E ACC MK 16 7
SACH  context+1 . {47 ACC )7 16 £i7
SAR AR1,context+2
SAR AR2,context+3
SAR AR3,context+4
SAR AR4, context+5
SAR AR5, context+6



LDP #OEOH

LACC  PIVR1 MR PR R A AR (PIVR) JEAB—N7
ADD #PVECTORS i AR ] Uk
BACC SRR 1 =R R 451 R

T1GP_ISR: AEAERZE LA D

LDP #DP_USER
LACL 10_COUNT
ADD #1
SACL  I0_COUNT
(USRI R]
LDP #DP_EVA
SPLK #OFFFFH,EVAIFRA
LDP #0
LAR AR5, context+6
LAR AR4, context+5
LAR AR3,context+4
LAR AR2,context+3
LAR AR1,context+2
LACC context+1,16
ADDS context

LST #1, stl_temp

LST #0, st0_temp

CLRC INTM T AR W, DR A — a3k R s B 856 P HR T
RET

; (100 ey

PHANTOM
KICK_DOG AT
RET
END
LT BERR LED KRGk Bon Bk
—. SEIGULHA

£ DSP N 2G4, M SEIN — — MR, SR RIS AN D AT D [ D) RERL
PEASZIG R BEE A, TR i S A 17O S AR, T 1O S 1A e v st o 6 —h
TR B AL . LED ML an i 4.1 s
—. ERHKM

1. ZFoPl AR 5 R e A g e ik

2. HE—BIAI TMS320LF2407 25 A 1 1O S 1 Bh fig Kzl 72
= TBRAR

1. H TMS320LF2407 .t v ik FF R — ARl 8 HUAOL WA 1% 8 Fhfest ior.

2. ShfsE e S FARTRIZhRE,  DASEIUN RO AR G H U R S s AS il



M. SKRSERFHE

MR, AE 8 AL A SR R DR
PO AR, 1% 8 Uy —MEM N M bk K2 8, KAEBUE A0 —

B SRR 15 4% R IR K3 B, R BROE MO R A BAE AR 1AL %

K4 GEAZEEIN, R BES e kOE A RI.

FIE T E 4% 14 10ms 7E 58, T rP kg R 7 2 SEBLE I, #3250 21 10s

GERT

C &7

110 3 14 Sy N ATy H 1]
VLAY

() Pt S AN ) e O “vectors.asm” [l FRT. AEIXLAS MBTA GRS, BB

UiA, vectors.asm #S AR o
3 ERF

11 ZRE e TR R, LB DL LED &oR

#include "register.h"
Il WIsa e 1R
initial()
{
asm(" setc SXM™);
asm(" clrc OVM");
asm(" clrc CNF");
*SCSR1=0x81FE;
*WDCR=0x0ES8;

*IMR=0x0000;
*IFR=0x0FFFF;
*MCRA=*MCRA&OXOFF;
*PBDATDIR=*PBDATDIR|0x0FF00;
*MCRC=*MCRC&O0x03FF;
*PFDATDIR=*PFDATDIR|0x0400;
*PBDATDIR=*PBDATDIR&0x0FF00;
*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&O0X0FFFB;
11 VA E A AN ikt i LED 495K
}
I B T R
void inline disable()

{
asm(" setc INTM");
}
int keyscan()
{

intk, j;

I 3RS ALy

I B nasH 4 B IR i

11 BO T A 30 A7 ik 2 1)

/I CLKIN=6M, CLKOUT=4*CLKIN=24M

Il RAEREE 14, A% SCSR2 ') WDOVERRIDE
11 B WD LRy 67 S A7 JE B (A 1, AT BUH
Il AT BT

I 25 BT A

I ERRAFR T WTER S, "5 13 0"

/1 1OPB i It ' Sk — 1) 110 Thig

/1'\OPB 3ify 115 & Ay i H 75 2K

/1 VOPF2 i F1A11 |OPF3~6 it '& h— %1 110 Lifig

11 VOPF2 3 I gy i3 1, 1OPF3-10PF6 g iy A%t 11
I JEK A LED 4T

I1oPF2 W& A7, H IOPF2=1

I/ TOPF2=0

15 S ey A

%N KLEE, 7] Rise 8 R AR &Y



}
int

{

k=*PFDATDIR&0x0078;
if(k == 0x0078)  k=0;

else k=1;
if(k ==1)
{

for(j=30000; j>0; j--) j=j;

k=*PFDATDIR&0x0078;
if(k == 0x0078)  k=0;
else k=1;

}

return(k);

keyserve()

int  k;
k=*PFDATDIR&0x0078;
switch(k)

{

11 B NBERDIRE I 5 5 AH N PR A7

I ATREE T, ) k=1
I FHTRHLT, W AR A

I FARALT, TR )
11 B NBERDIRE I 57 H 5 AH N PR A7

I HieERE T, W k=1

IR K AE

/

<

BRI

15 Sy A &
11 B NBERDIRE I 5 H 5 AT N PR A7

<

case 0x0070: *PBDATDIR=(*PBDATDIR&O0xFF00)|0X0001; break;

I A53% T KL g, )RRt

case 0x0068: *PBDATDIR=(*PBDATDIR&O0xFF00)|0X0002; break;

I A53% T K2 g8, )R

case 0x0058: *PBDATDIR=(*PBDATDIR&O0xFF00)|0X0003; break;

I F53% T K3 g, ) §oR 3t

case 0x0038: *PBDATDIR=(*PBDATDIR&O0xFF00)|0X0004; break;

I F53% T K4 g, ) oR 4n

default: *PBDATDIR=*PBDATDIR;

}

*PFDATDIR=*PFDATDIR|0x0404;
*PFDATDIR=*PFDATDIR&O0X0FFFB;

IMOPF2 ¥ My =X, H 10PF2=1
I 1OPF2=0

I VA Egs— Akt A8 B i AR 2 ok

}

main()

{

disable();
initial();
while(1)
{
inti;
i=0;
i=keyscan();

if(i==1) keyserve();

I BRI W

Il K&

1158 XA &

I BRI, FATRE T, RN, AR EHE G0
I A RA RS, AT B I 55 R



I BRI R iR % TR
void interrupt nothing()

{
return;

}
H{BE TP R g
st0_temp .usect ".b20",1 ;60
stl_temp .usect ".b20",1 ;61
context .usect ".b20",7 ;62-68
STACK . usect ".stack”,40
IOSFT_REG .usect ".data0",1 ;280 ; IOPB SHIFT REG
1I0_COUNT .usect ".data0",1 ;281 ; 10 COUNT REG
I0_DATA .usect ".data0",1 1282 ; VO I Hidls 22 b IX.
LEDXS .usect " data0",1 :283 : LED S~
LEDFLAG .usect ".data0",1 :284 : LED BoRkri&
K1FLAG .usect " data0",1 1285 P KL bR A7 5
KEYDATA. usect ".data0",1 ;286
KEYTIMER .usect ".data0",1 ;287
DP_USER set 5

.include "F2407REGS.H"

.def _c_int0

sect " vectors" 7B A I B
RSVECT B _c_int0 ;PMO Reset Vector 1
INT1 B PHANTOM iGISR1L  ;PM 2 Intlevel 1 4
INT2 B GISR2 ;PM 4 Int level 2 5
INT3 B PHANTOM ; PM 6 Int level 3 6
INT4 B PHANTOM ; PM 8 Int level 4 7
INTS B PHANTOM ;GISR5; PM Alnt level 5 8
INT6 B PHANTOM ;PMC Int level 6 9
RESERVED B PHANTOM PME (Analysis Int) 10
SW_INT8 B PHANTOM ;PM 10  User S/W int -
SW_INT9 B PHANTOM ;PM 12 User S/W int -
SW_INT10 B PHANTOM ;PM 14 User S/W int -
SW_INT11 B PHANTOM ;PM 16 User S/W int -
SW_INT12 B PHANTOM ;PM 18  User S/W int -
SW_INT13 B PHANTOM ;PM 1A User S/W int -



SW_INT14 B PHANTOM ;PM1C  User S/W int -
SW_INT15 B PHANTOM ;PM1E  User S/W int -
SW_INT16 B PHANTOM ;PM 20 User S/W int -
TRAP B PHANTOM ;PM 22 Trap vector-

NMI B PHANTOM ;PM 24 Non maskable Int3
EMU_TRAP B PHANTOM ;PM 26  Emulator Trap 2
SW_INT20 B PHANTOM ;PM 28 User S/W int -
SW_INT21 B PHANTOM ; PM2A User S/W int -
SW_INT22 B PHANTOM ;PM2C  User S/W int -
SW_INT23 B PHANTOM ;PM2E  User S/W int -
SW_INT24 B PHANTOM ;PM 30  User S/W int -
SW_INT25 B PHANTOM ;PM 32 User S/W int -
SW_INT26 B PHANTOM ;PM 34 User S/W int -
SW_INT27 B PHANTOM ;PM 36  User S/W int -
SW_INT28 B PHANTOM ;PM 38  User S/W int -
SW_INT29 B PHANTOM ;PM3A  User S/W int -
SW_INT30 B PHANTOM ;PM3C  User S/W int -
SW_INT31 B PHANTOM ;PM3E  User S/W int -

s R IRE T 1R B N S8 X pvecs

sect " pvecs" s F Il = B
PVECTORS B PHANTOM i PRE ) bk AL -0

B PHANTOM s DR BE ) bk RS

B PHANTOM o R H T B 01 R A

B PHANTOM R =2 H T B 01 R 2 A

B PHANTOM =2 H T B 01 R 2 A

B PHANTOM ;AR ) Rk RS & -0

B PHANTOM ;SCI_RX_ISR ; &M JEﬂ'ﬂﬂHﬁ*Z%

B PHANTOM ;SCILTX_ISR ; {8 o Btk fwfs &

B PHANTOM s PR BE ) b RS

B PHANTOM s PR BE ) b RS

B PHANTOM ;R 1) Sk R RS & -0a

B PHANTOM s DR BE ) b A

B PHANTOM o DR BE ) b RS

B PHANTOM =2 H T B 01 R A

B PHANTOM o (R H T B 01 R 2 A

B PHANTOM o PR B ) b RS

B PHANTOM s R ) Sl s - 10

B PHANTOM o (=2 H T B 01 R 2 A

B PHANTOM o (R 2H T B 01 R 2 A

B PHANTOM ;DR 1) R B

B PHANTOM ;DR 1) R B



0 W 0 0 W W 0 W W 0 W W W 0 W W 0 W W W 0 W ™ 0 0 W W 0 W ™ 0 O W W 0 W I W 0 W W 0 W @

PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
T1GP_ISR

PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM

o B ) R (WA - 15
AR SRR &

{

;DR ) b (R %
; DRE ) b (%
;DR 1) b (R %
;DR ) b (R %
;DR 1) b (R %
;DR 1) b (R %
;DR 1) b (R %
; DRE 1) b (R %
; DRE 1) b (R %

;R ) R (W A B -20

-la

O O ﬁm WD |

l

AR R S

; DRE ) b (R %
; DRE 1) b (R %

o AR 1) AR R

o R B 1) Sk fn A% 525

o B 1) R U RS

i ORE ) bl (R A% #-0027 TIPINT
o B 1) R U RS

s PR 1) B RS

o R B R B R -2a

;B 1) R U RS

; DRE ) b (R S
; DRE ) b (R S

s PR ) R R

; pvector addr offset 0x02f - T3PINT
;PR E n) b S -30

i PRE e bk RS e

; DRE ) b (R RS
; DRE 1) b (R %

R ) E R A
AR BE B A% B -35
'%%M%ﬂm%%%

'%%Wﬁﬂm% BE

o AR A = RS = -3a

AR R S

; DRE ) b (R %
;DR 1) b (R %

o AR 1) AR R
o AR 1) Rk R R -3
:CANMBX_ISR ; {48 | S bl 7% &



B PHANTOM s B ) R (WA -4

FEITB

 BIE X 4 K1=IOPF3, K2=I0PF4, K3=IOPF5, K4=IOPF6, LED f{] A 155 :10P
; WREE A 4 ML 8 MR TAE A ST, FEUCHHL TR KA d RN e N A 107, IR R 8
ANRICIE
KL 3% RN RER, S8 BN R B7s 1 RO iR AR
yK2 RN 47 B, i —, RORARINROE R
K3 5 FMAREAIR, $%— A4 —F7, B LED7=LEDS...LED1=LEDO, LEDO=LED7
; VEE LED S RIHEESCH LCD r¥ik E1F1E2
text

_c_int0
CALL INIT S
CALL  KEYLEDINIT
LDP #DP_USER
SPLK #01H,IOSFT_REG ;B REEEAL 2747 2%
SPLK #00H,I0_COUNT &N H 5 17es
SPLK  #001H,I0_DATA ;I/O Il ¥t 22 nhIx
SPLK #001H,LEDXS ;LED R 54
SPLK  #00H,LEDFLAG i LED Borbri& %474 LEDFLAG.0=1 %Kk
i K1,K2,K3 #%F
; LEDFLAG.0=0 £/~ K4 &
SPLK  #01H,KIFLAG KL bR Ao
CALL  INIT_TIME1
LOOP:
CALL  KEY
LDP #DP_USER
BIT LEDFLAG,15
BCND  LEDBD1,TC
LACL  10_COUNT
SuB #030H
BCND  WAIT,LEQ
LEDBD1:

SPLK #00H,I0_COUNT

LDP #DP_PF2

LACL  PFDATDIR

OR #0004H ; IOPF2 it 1

SACL PFDATDIR T 74AHC273 Fikfs 5



LDP #DP_USER
LACL LEDXS

OR #OFFOOH : IOPB 2%t
LDP #DP_PF2
SACL PBDATDIR ;IR BRI EE

LDP #DP_PF2

LACL  PFDATDIR

AND #OFFFBH JIOPF2 #ith 0

SACL  PFDATDIR K TAHC273 FikfE S

LDP #DP_USER

BIT LEDFLAG,15

BCND  LEDBD2,TC

LACL  LEDXS

SFL ST RINIE Can: S A
SACL  LEDXS

LACL  IOSFT_REG

SFL
SACL  IOSFT_REG
BIT IOSFT_REGBIT8 ; HETIEITE—IK
BCND  LOOP1,TC
B WAIT
LOOP1:
LDP #DP_USER
SPLK  #01H,IOSFT_REG
LEDBD2:
LACL  10_DATA
SACL  LEDXS
WAIT:
NOP
B LOOP
INIT: T RGHIEA
SETC INTM KR4 ey b
CLRC  SXM AERTT YR
CLRC OVM
CLRC  CNF ; BO L& B A )

LDP #OEOH
SPLK #81FEH,SCSR1 ; CLKIN=6M,CLKOUT=24M



SPLK #0E8h,WDCR ; RHIE T WDT
LDP #0
SPLK #0002h,IMR ; flifg interrupt 2
SPLK  #OFFFFh,IFR L T
RET
INIT_TIMEL: SEI 2R 1A TR
LDP #DP_EVA
SPLK #80H,EVAIMRA TTE 2% 1 8 ik
SPLK #OFFFFh,EVAIFRA; T EVA T P ke & (5 1)
SPLK  #0,GPTCONA A3 ADZE I eI 8 1 L
SPLK #0BBH,T1PR AL E I 2$5F 1ms 24—k P b
SPLK #00H,TICNT EENEE 1R
SPLK  #0174CH,TICON  ;TMODE=10(#4:Hifit),
;TPS=111 X/128,,CLOCK=Internal, J&iz5E it 4% 1
CLRC  INTM
RET
KEYLEDINIT: B LED Wl TR
LDP #DP_PF2
LACL  MCRC
AND #083FFH ; IOPF2--10PF6 it ‘& — (¥ 1/0 1
SACL  MCRC
LACL  MCRA
AND #000FFH ; IOPB[0-7] Mic& A —M ) 1/0 [
SACL  MCRA
LACL  PFDATDIR
OR #0400H ; IOPF2 Sfyfirh 7720
AND #087FBH ;IOPF[3-6] A AJ7
SACL  PFDATDIR
LACL  #OFFOOH ;IOPB[0-7] Myt /7 =X
SACL  PBDATDIR
RET
KEY:
CALL  READKEY RERH EhRIE]
LACL  KEYDATA
BCND  KEYRETEQ : ACC=0?
CALL  KEYDELAY ; KEYDATA A% T 0,87 A 4% N &N HHH3)
CALL  READKEY VR ER AR AT N TR T



KEY1:

KEY2:

KEY3:

KEYRET:

BCND
LDP
BIT
BCND
CALL

BIT
BCND
CALL

BIT
BCND
CALL

BIT
BCND
CALL

LACL
AND
SACL
RET

KEYRET,EQ
#DP_USER
KEYDATA,15
KEY1,NTC
K1

KEYRET

KEYDATA, 14
KEY2,NTC
K2

KEYRET

KEYDATA,13
KEY3,NTC
K3

KEYRET

KEYDATA,12
KEYRET,NTC
K4

KEYDATA
#OfffOh
KEYDATA

IR DL 1 U AR F)

s KEY1 Jfig

KEY2"+"%

TKEY3 "B g

KEY4 ffhilf

F KEYDATA I 4 fi7

B T R B 5 L1 AEAEAAAEAAAAAAAAAEAAAAAAAAAAAA A AR AR A Ak AAhhdhkhk
; S TR

READKEY:

KEYDELAY:

KEYD1:

LDP
LACL
RPT
SFR
OR
CMPL
LDP
SACL
RET

LACC

SUB
RPT
NOP
BCND
LDP

#DP_PF2

PFDATDIR

#2

#0fffOh

#DP_USER

KEYDATA

#6000

#1
#080H

KEYD1, NEQ
#5

s FIREDRAS TR

; DP-->7080h-70FFh

; I { PFDATDIR.3--PFDATDIR.6
AR 340

;R 46 (R34 D

AR T I A AR A A R 2 5 A e

B RAEAE KEYDATA

; BEALSER TR 86ms(20000) 30mS(6000)

: JEIN 30mS Y1)



RET

v kkkkkhkhkkhkhkkhkhkhkhkhkhkhkkk ok (1 *hkkkhkkkhkhkhkkhkhkhkkhhkhkhhkhkkhhkhkhhkikihkhkkx
; inett Ty

K1:

READK1:

GN_KEY1:

GN_KEY2:

GN_KEY3:

GN_KEY4:

GN_KEYS:

NOP

CALL
CALL
LDP
BIT
BCND
LDP
SPLK
BIT
BCND
BIT
BCND
BIT
BCND
BIT
BCND
BIT
BCND
BIT
BCND
BIT
BCND
BIT
BCND
B

SPLK

SPLK

SPLK

SPLK

SPLK

READKEY
KEYDELAY
#DP_USER
KEYDATA,15
READK1,TC
#DP_USER
#01H LEDFLAG
K1FLAG,15
GN_KEY1,TC
K1FLAG,14
GN_KEY2,TC
K1FLAG,13
GN_KEY3,TC
K1FLAG,12
GN_KEY4,TC
K1FLAG,11
GN_KEY5,TC
K1FLAG,10
GN_KEY6,TC
K1FLAG,9
GN_KEY7,TC
KIFLAGS
GN_KEY8,TC
K1_RET

#01H,10_DATA
K1_LOOP1

#03H,10_DATA
K1_LOOP1

#05H,10_DATA
K1_LOOP1

#007H,10_DATA
K1_LOOP1

#11H,10_DATA
K1_LOOP1

;AW KL 2T

s AT 16 ANEE £ 43

KL 55 1 RN R 1H

KL %55 2 RN 7R 3H

KL %55 3 RN 7R BH

KL 255 4 RIS 7R TH

KL %55 5 R R 11H



GN_KEYE6:

SPLK

GN_KEYT:

SPLK

GN_KEYS:

SPLK

K1_LOOP1:

LACL
SFL
SACL
BIT
BCND

K1_LOOP2:

K1_RET:

READK2:

SPLK

NOP
RET

TR

NOP

CALL
CALL
LDP
BIT
BCND

LDP
SPLK
LACL
ADD#1
SACL
RET

"B TR

NOP

#33H,10_DATA
K1_LOOP1

#55H,10_DATA
K1_LOOP1

#77H,10_DATA

K1_LOOP1

K1FLAG

K1FLAG

K1FLAG7

K1_LOOP2,TC
K1 _RET

#01H,K1FLAG

KL %255 6 WRIN i 33H

KL 55 7 YR i 7 55H

KL %255 8 WRIN iR 77H

:KIFLAG £

READKEY
KEYDELAY
#DP_USER
KEYDATA, 14
READK2,TC

#DP_USER
#01,LEDFLAG

|0_DATA

|0_DATA

AR K2 EERIT

;. %M LED A% Frid, Bl LED X [d— 0N Hr




READKaS:
CALL
CALL
LDP
BIT
BCND

LDP
SPLK
LACL
SFR
SACL
BCND
LACL
ADD

K3_LOOP1:
SACL

RET

m====== TR

NOP
READKA4:

CALL

CALL

LDP

BIT

BCND

LDP
SPLK

SPLK

RET

READKEY
KEYDELAY
#DP_USER
KEYDATA,13
READKS3,TC

#DP_USER
#01H,LEDFLAG
I0_DATA

I0_DATA
K3_LOOP1,NC
#80H
I0_DATA

|0_DATA

; AW K3 2T

:C=1 Il 10_DATA+80H

READKEY
KEYDELAY
#DP_USER
KEYDATA,12
READK4,TC

#DP_USER
#O0OH,
#01H,

D HIrEEE KA R EIAT

LEDFLAG; & LED A#tri&
I0_DATA

;************************* % []j‘ gg: E':] [iﬁ % }5’2 r_‘ *hkkkkkhkhkhkkhkhkhkkhhkhkhhkhkkhhkkikhhkihhkikiik

GISR2: LDP
SST
SST
SACL
SACH
SAR

SAR

#0

#0, stO_temp
#1, stl_temp
context
context+1
AR1,context+2
AR2,context+3

s PRAEHLES R

; A A sS4k, DP-0

i PRAFIRAS 75 /745 51 B2 DARAM.
. {17 ACC I 16 47

; IR7F ACC Hw 16 1



SAR AR3,context+4

SAR AR4, context+5
SAR AR5, context+6
LDP #0EOh ; A PIVR £ %7 f7 45 12503 DP
LACC PIVR,1 ; B¢ EVIVRB, £ 117
ADD #PVECTORS s IS [r) B 3R )
BACC
T1GP_ISR:
LDP #DP_USER
LACL 10_COUNT
ADD #1
SACL  10_COUNT
GISR2_RET:
LDP #DP_EVA
SPLK #OFFFFH,EVAIFRA
LDP #0
LAR AR5, context+6
LAR AR4, context+5
LAR AR3,context+4
LAR AR2,context+3
LAR AR1,context+2
LACC context+1,16
ADDS context
LST #1, stl_temp
LST #0, st0_temp
CLRC INTM
RET
PHANTOM
KICK_DOG ; Resets WD counter
RET
END
LN B/ B Hds ADC M
—. SEEUH

B NI BT HARK) T 223900, %1 ADC HIPEREFRARSR L 1 2% Tl & 1 A ] 22
Ko IR T 4 BRI R 22 (1 DR & I BL ADC. HR ADC X FEIFIHE
PR DV RS R R IS B HOLI, (R, FIHT IR A BRI IG5, ok
L AT RELE LB L. DSP B W, DAREIE MO Fr il i oAl Lt F
ARG (SOC). P AL I ANt 1) Tl 2 AT T g P DL K 0 3 2 P PR Rl o



7 TMS320LF2407 .t5 )7 WECE T 47 10 7 B4 16 MR IE 1) ADC A, AR RS 3=
PR T Y UF TMS320LF2407 Jr P ADC BEEIRE, 1 TMS320LF2407 A5 )7 3k S8 —A
FUEIE Y 10 7 AID B4, WIERE ADCIN I8 2 — 1 ARG 4N, IR gl
DLt B Z IOPB M5 74HC273 Bifr#s M BEH:M 8 MO S i o nf LGB,
e o S Bt A RS AR AT AR Ak, AT AT ALEBRATT T A 9 ADC BEER 1 T AR o
—. ERHKM

1. T f# TMS320LF2407 t5 Fr [t ADC Kb 45 b A ShHE v BhAg .

2. HE4EXT ADCIN i )5 D) RE s E, % st Rl ADC N HREY, 2k
el J b IR AR
= ZBHAE

1. kP AID B EiE . ek AID B s ThRE, KA AID 51T E AN,
VKB AID e dopsi o) T I

2. WA AL 8 L LED Kt AR S B 3k B R e R

3. ERMIZIGHE P4 N 0~+3.3V HiitHL Ik, P3N —3.3V~+3.3V i Hl
V9.  SEEGHE (4 ra gk

& W P4,P3

o]
AGHD 8 1 ADIHD -
] 2 ADINL P
10 I ADIN2 SR G
11 4 AGHD |
12 5 ADINE [
13 6 ADIND 00l
| 14 7__ADINID LGHD
ACTH .
AMPLa
11k
apmn R R = 2 [
3'r' — 1 ADCIHOD
1+
—_—l .-
00470
o MCDG04
E =
AGHD = Iy
T4
AGHD _ 11 1 ADCINOE
s 12 2 ADCIHNDS
112 ADCIHOD 13 3 ADCINOS
ﬁg%”l 110 AT CIHO1 14 4 ADCIHOG
Bt 107 ADCIHOZ 135 3 ADCINOT
it 105 AT CIHOZ 16 6 ADCINLL
Bt 103 ADCIHN04 17 7 ADCINIZ
o 102 AT CIHOS 13 8 ADCINLE
T 100 AT CIHOG 10 o ADCINL4
ot 00 AT CIHOT | 20 10 ADCINLS
TMSZ20LF2407 LCIH
&l ADC RE{ e it
%. ERSEBRFHR
H
CiEsHER
#include "register.h"
int ADRESULTI[16]; I8 X — A TR A7 AD el g5 4
volatile unsigned int *j; Il L — e

int i=0x00,cesi;



void inline disable()

{

asm(" setc INTM™);

void inline enable()

{

asm(" clrc INTM");

initial()

{

}

asm(" setc SXM");
asm(" clrc OVM™);
asm(" clrc CNF");
*SCSR1=0x81EF;
*WDCR=0x0ES;

*IMR=0x0001;
*IFR=0XOFFFF;

11 AD WG TR
void ADINIT()

{

}

*TACNT=0x0000;
*TACON=0x170C;
*TAPER=0x75;
*GPTCONB=0x400;
*EVBIFRB=0x0FFFF;
*ADCTRL1=0x10;

*ADCTRL2=0x8404;

*MAXCONV=0x0F;
*CHSELSEQ1=0x3210;
*CHSELSEQ2=0x7654;
*CHSELSEQ3=0x0BA98;
*CHSELSEQ4=0x0FEDC,;

Il RS AT 2%

I BT Hh 4k JL 1 s

11 BO T A 3 A7 it 4 1)

/I CLKIN=6M, CLKOUT=4*CLKIN=24M

I AMEifeE T4, K% SCSR2 ) WDOVERRIDE
11 B WD Ry 67 S A7 JE B A 1, AT BAUH

I BATEEEBR T

Il FSVF INTL I
I SRR, S 13 0"

11 T4 V#8050

I T4 F L Mok, 128 43045, Lk FH P 0 ) el
I B T4 WS ZA7 2

11 T4 JE 3 Wiks 5 ik % AD %46t

Il kR EVB bR, BN 0

/1 RIS ] % 1 5 Ff. ACQ PS3-ACQ PSO 24 0,

I e R T2 AR CPS 4y 0, AD A shifE ks, HE
I PR AYIETAE I 3, AR IERR IR PR TAERE
I FTLLH EVB [—AN g5 S ik AD #546,

I B 1

/116 3WiE

Il 350838 /2 0-15

11 JAE)) AD et 1R e (A 2l I8 4 4 1977 3000 12 05 30)



void ADSOC()

{
*TACON=*T4CON]|0x40;
}
112 FCre v W ) R ] R e
void interrupt nothing()
{
return;
}
11 AD TR 55 1 FE
void interrupt adint()
{
asm(" clrc INTM™);
J=RESULTO;
for(i=0;i<=15;i++,j++)
{
ADRESULTIi]=*}>>6;
cesi=ADRESULTTi];
}

*ADCTRL2=*ADCTRL2|0x4200;

enable();

main()
{
disable();
initial();
ADINIT();
enable();
ADSOC();
while(1)
{
if(i==0x10)
break;

}

*TACON=*T4CON&OXOFFBF;

while(1)
{

LRz

I JABhE R 2% 4

I RS0
/I B45 RESULTO [ sk

It AD B 45 A 6 A5 7 N HE AL
I K344 AID B it 4 51

Il 547 SEQ1, HiFF& INT FLAG SEQ1 Ar&’5" 1" 0
I JE R, By —aE A b SR Wt B 3 oe i T

1151 S i

I RGEAIARN,

Il AD WAL T 1L
11 I

Il A5l AD i

IR EA R W, W ESA CRAETWIS, i=0x10)
I SRR R AR
I 151 E T 8s 4, B34 E A/D $ed

11 FEAEER, 15 SEFR I TREN A R ZE Tl LRI AID #e ¥ 11
Il ST s



st0_temp
stl_temp
context
STACK

ADCOUNT

ADRESULT .

(1) B R R

RSVECT
INT1
INT2
INT3
INT4
INT5S
INT6
RESERVED
SW_INTS
SW_INT9
SW_INT10
SW_INT11
SW_INT12
SW_INT13
SW_INT14
SW_INT15
SW_INT16
TRAP
NMI
EMU_TRAP
SW_INT20
SW_INT21
SW_INT22
SW_INT23
SW_INT24
SW_INT25
SW_INT26
SW_INT27
SW_INT28
SW_INT29
SW_INT30
SW_INT31

.usect
.usect
.usect

.usect

usect

usect

.include

def

.sect

B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B

".b20",1
".b20",1
".b20",7
".stack”,40

".data0",1
".data0",1

"F2407REGS.H"

_c_int0

".vectors"
_c_int0
GISR1
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM

ClV PSS Es

s S T B

;PM 0O
;PM 2
PM 4
;PM 6
;PM 8
PMA
PMC
PME
;PM 10
; PM 12
;PM 14
; PM 16
; PM 18
; PM 1A
;PM 1C
; PM 1E
; PM 20
; PM 22
i PM 24
; PM 26
; PM 28
; PM 2A
;PM 2C
; PM 2E
; PM 30
; PM 32
; PM 34
; PM 36
; PM 38
; PM 3A
;PM 3C
;PM 3E

BER VAR

kT ek 1
Tl ek 2
Tl e 3
Tl SE S 4
Tk e 5
ke 6

BEALL i\ P T (PR 7)

F 58 SCRAT T
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
Trap vector-

Non maskable Int3
Emulator Trap 2
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
User S/\Wint -
FH P SRR AT A

© 00 N o o b~

[EEN

0



s HH T ) B N T S pvecs

PVECTORS

.sect

".pvecs”
PHANTOM
PHANTOM
PHANTOM
PHANTOM
ADCINT_ISR
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM
PHANTOM

E XTI R B

R B i) S B S
R B i) B S
R B 1) S
R B i) B S
R B 1) B S
R B ) B S
:SCI_RX_ISR; 55 [ ft Hudil- g B 5t
SCLLTX_ISR ; {4 [ Ribhtwts &
o AR A B A
o AR A B A

DR B ) e S =

AR R RS

l

o R B 1) Sk fR RS
R R B 81 R (2 A
; DRE 1) s b
; DRE 1) s b
; DRE 1) s b
; DRE 1) s bl
; DRE 1) s b
; DRE 1) s b
; DRE 1) s bl
; DRE 1) s b
; DRE 1) s bl
; DRE 1) s b
; DRE 1) s bl
; DRE 1) s bl
; DRE 1) s bl
; DRE 1) s bl
;DR i) s bl
; DRE 1) s bl
; DRE 1) s b
;DR 1) s b O
;DR 1) s b
; DRE 1) s b O
;DR I s b
;DR fh) s b
;DR 1) s b
;DR I s bl
;DR 1) s b
;DR I s b
;DR 1) s b
;PR 1) S bl g

ireive i e ive Sl ve i sl ve Sl v sl ve Sl v ro S ve Sl vl re Sl ve S vl ro v vl e ve v i ro v vl
+HHD1 i +HHD1 R +HHD1 O 1 +EUJ 1 +EUJ 1 +EUJ S

v

0000h
0001h
0002h
0003h
0004h
0005h

-0a

-10

-15

-la

:-20

0-25

r-2a

ADC H I



D (2) LR

_c_int0

WAIT.

: (3) ADC WAL IR 7

ADINIT:

W W 0 0 @ W 0 @ W 0 0 @ W 0 @ W 0 0 W W I W @

text

SETC
CLRC
CLRC
CLRC
LDP
SPLK
SPLK
LDP
SPLK
SPLK
CALL
CLRC
CALL
NOP
B

LDP

PHANTOM o AR B ) B A
PHANTOM o AR ) B A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM ; pvector addr offset 0x02f - T3PINT
PHANTOM i PR R b ik A% 30
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM i PR ) ik A% B35
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR R B A
PHANTOM o AR A B A
PHANTOM i URE ) bR RS -3
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR ) B A
PHANTOM o AR ) B A
PHANTOM i PREE ) bk S - 3f
PHANTOM ;CANMBX_ISR ; {4 [ Stttk s =
PHANTOM SRR ) LB B 0041h
INTM

SXM

OVM

CNF

#OEOH

#81FEH,SCSR1 :CLKIN=6 M,CLKOUT=24 M
#0E8h,WDCR SR T

#0

#0001h,IMR FOVE INTL Hh b
#OFFFFh,IFR RV RER Rl Y S

ADINIT WGk ADC F27

INTM S TE L T

AD o BB R

WAIT

#234 SRR E I 4% 4



s (4 R

AD:

; (5) L

GISR1:

SPLK
SPLK
SPLK
SPLK
SPLK
SPLK
LDP

SPLK
SPLK
SPLK
SPLK
SPLK
SPLK
SPLK
LDP

SPLK
RET

LDP
LACL
OR
SACL
RET

R7SIAE R

ADCINT_ISR:

LDP
SST
SST
SACL
SACH
SAR
SAR
SAR
SAR
SAR
LDP
LACC
ADD
BACC

CLRC
LDP

#0000H,TACNT
#170CH,TACON
#075H,T4PR
#0400H,GPTCONB
#OFFFFH,EVBIFRB
#0000H,EVBIMRB

#DP_PF2
#0010H,ADCCTRL1 ;% & ADC 5l %5 17 0%
#8404H,ADCCTRL2

#000FH,MAXCONV ;16 i
#3210H,CHSELSEQ1
#7654H,CHSELSEQ?2
#0BA98H,CHSELSEQ3
#OFEDCH,CHSELSEQ4

#DP_SARAM?2 ;¥ 1] 0A00h~0A80h
#ADRESULT,ADCOUNT

#234

T4CON

#40H R BIE N2 4
T4CON

ARSELE INTL I FRF A

#0  IRAEHLAS BN

#0, st0_temp ¥ H 1 3 S-4k DP-0

#1, st1_temp ; RAFIRES T A7 75 £ B2 DARAM.
context : {547 ACC KIS 16 7

context+1 : {%1F ACC 1 16 7
AR1,context+2

AR2,context+3

AR3,context+4

ARA4,context+5

AR5, context+6

#OEOH

PIVR,1 MR PR R A A2 (PIVR) I
#PVECTORS SNBSS

SRR RV P T TR 55 R

SXM
#DP_SARAM2



LAR
LAR
LAR
MAR
ADCL: LACC
SACH
ADRK
MAR
BANZ
LDP
LACL
OR
AND
SACL
LDP
LACL
SuUB
BCND
ADD
SACL

ADC2: SPLK
LACL
AND
SACL

GISR1_RET:
LDP
SPLK
LDP
LAR
LAR
LAR
LAR
LAR
LACC
ADDS
LST
LST

KA
CLRC
RET

; (6) fErhwife

AR1,ADCOUNT
ARO,#15
AR2,#RESULTO
* AR2
*+,10,AR1

*

#32

* ARO
ADC1,*- AR2
#DP_PF2
ADCCTRL2
#4000H
#OFFDFH
ADCCTRL2
#DP_SARAM2
ADCOUNT
#ADRESULT+31
ADC2,GEQ

#ADRESULT+32 ;<32

ADCOUNT
GISR1_RET

;547 SEQ1
4% INT FLAG SEQ1

#ADRESULT,ADCOUNT ;=32

TACON
#OFFBFH
TACON
GISR1_RET

#DP_EVA

#OFFFFH,EVAIFRA

#0

AR5, context+6
AR4, context+5
AR3,context+4
AR2,context+3
AR1,context+2
context+1,16
context

#1, st1_temp
#0, stO_temp

INTM

AZ N A 4, 8142 AD B

sHR TR R

TS R T, DX — kR Wt B 3h 0% P TR R



PHANTOM
KICK_DOG AL T4
RET
END

4w RATANEE D SPI N A

—. ERULEA

SPI 2 ph 3 [ BEFE B R A w] dpe Se 4k tH I — B R0 FRAT AR LS, DSP At v B 8347
PREFET SPL. SPI 32210 =B IR AN B AT 82 1 I 0 S A EA T 18 VR ) — R AT vz 1
T H 2% SPLZ OAME g 1F, HASIEAD . B, SRS B, E5R R H
BT G 1 A

SPI 22 1] LL[R] I e 26 A 8 A et , & ILAE I T 4 451 1:

*SPI MELPEETN / 8 B CRIFR SPISIMO): 1B 2E—/N 7 1) At S
JeikE (MSB), JEiE &AL (LSB).

*SPI MESAETH / E RN S CRIRR SPISOMD: 5 Rt & 76— A7 i) AL %40 .
FEIE L, JEIERAT . R NER B Bk T, B SOMI Zi4b T = BHARAS

*SPI AT B | (FIFR SPICLKD: - HI T3, MERFZ [0 7E MISO 1 MOSI £ I f%i%
AR AT D o B2 N 2R, 7 NS AE N NS . 7E 8 NIHEI I 2 Y,
T B2 A S A S EIAS . SPISCK SE MHE 5 th 8 A 35 B At

*SPI AT R IEAERES I (AR SPISTED: X T LA T A0 A, SPISTE i
NG FMEIETAS S5 NS, 127 | 200 A a2 a2 W e 1 A FBY, I FLAE AN Sl A%
IR e R AR PR T ST TAE T R8RS H, SPISTE i A\ £ 202 my Ha
o

7 DSP v P AT (P TEE Af  050 dar SRE A R A P o = W 5 SR, ] AR )20 472
KA ATl F AN S Fr o ASSZG R A SPI #2111 DAC {5 A MAX5121, FIT HARR S
PR, LNV JREE: i TMS320LF2407 1% H IMEC B 4 AT i #2101 SPI K B R
SHAE DAC IS A b, 2 DAC M BRGS0 ik, e i g r sk
MIIESEW . — PSS TR 5
—. ERHKM

1. JEZR SPI 2 1 RIS 5 B In) R 7 5326 —AN 71 B3l R MAKS J7 B — 7 1 40l v A T
I ThRE -

2. PR S R ATE AN B R R D vk, WILE . AU DSP N RS
JEJTIEFT T Ao
= TBHAR

1. [ MAX5121 5 F T REr = AT 5 IE BT A Y 1 34

2. KEUTME 'S4 DAC B R RG2S . i S i e s R ARt . AT
VY. SEEGHE{:F BE



ul

AGND 1 % 3
\Veo U2 «
16 1
AGND_Cli| —15 | 228 ogf 2 | DAOUT
M REFRSTVAL — “l 8o reser
>— AGND  PDL ———VvCC | % — CLOCKOUT/IOPEO
T PD OR —3 5 SPISIMONOPC2
0 UPO Ccs 7 | 3 SPISOMI/IOPC3
| DOUT DIN 8 = O| SPISTE/IOPCS
_I_i‘ DGND SCLK SPICLK/IOPCA

MAX5121 TMS320LF2407

7.1 TMS320LF2407 5 MAX5121 3O B %

MAX5121 ] SPI $: 13644 9 4%, XH 16 frifEnd, HEREmh 3 i, 12 47
Bl S LA AL k. HARAHEWER 7.1 s,

F 7.1 MAX5121 By SPI $EO¥E4S &

16 7 HAT S
c2 | c1| co D11-+--DO S0 e
0 0 0 | XXXXXXXXXXXX | 0 | &k
0 0 1 12 fii. DAC % 0 | BAMINZATA:, DAC 79 AZEIf314] DAC
0 1 0 12 fi. DAC ¥k 0 | [RIINAE N AR DAC 251723 3F <1 DAC
0 1 1| XXXXXXXXXXXX | 0 | fef N AEas A A\ B DAC 47495
1 0 1| XXXXXXXXXXXX | 0 | X4 DAC 44 PDL=1)
1 0 0 | XXXXXXXXXXXX | 0 | UPO 5l ki i~ F
1 1 0 | XXXXXXXXXXXX | 0 | UPO 5| _I-% &
1 1 1| IXXXXXXXXXXX | 0 | 77 1: DOUT 7 SCLK I bt Rk Hiciis
1 1 1 00X XXX XXX XXX 0 | J5300: DOUT 7 SCLK ) Ay K3 Bdim (e

Ti. ERSEHRFHE
CEEEF

#include "register.h"

int GPR3;

int flag?;

int flag;

int initial()

{
asm(" setc INTM™);
WSGR=0x00;
asm(" clrc SXM™);
asm(" clrc OVM™);
asm(" clrc CNF");
*SCSR1=0x81FE;
*WDCR=0x0ES;



int SPIINITIAL()

{
*SPICCR=0x004F;
*SPICTL=0x0006;
*SPIBRR=0x0007;
*MCRB=0x003C;
*MCRC=*MCRC&O0xX0FFFE;
*SPICCR=*SPICCR|0x0080;

int SPITRANS()

{
*PEDATDIR=(*PEDATDIR|0x0100)&0x0FFFE;
*SPITXBUF=GPR3;
while(1)

{

flag=*SPISTS&0x40;
if(flag==0x40)

break;

}

*SPIRXBUF=*SPIRXBUF;
*PEDATDIR=*PEDATDIR|0x01;

main()

{
initial();
SPIINITIAL();
GPR3=0x4000;
flag1=0x00;
while(1)
{
if(flagl==0x00)
GPR3=GPR3+2;
else
GPR3=GPR3-2;
if(GPR3==0x5FFE)
flag1=0x01;
if(GPR3==0x4000)
flag1=0x00;
SPITRANS();
}



void interrupt nothing()

{
return;
}
IComPET
JH P A A as e X
SPI_DATA .usect  ".data0",1 I N H s 25 A7 A
SPI_FLAG .usect  ".data0",1 ;SPI ARy
SPI_CON .usect “.data0",1 IMAX5121 (135 )7
DP USER .set 5 S AT BAT I TR B
MAX5121 5 8 X
DACOUT .set 4000h :C2C1C0=010
UPINREG .set 2000h :C2C1C0=001
UPDACREG  .set 6000h :C2C1C0=011
SHUTDAC set 0A00h :C2C1C0=101
(D ERF
include "F2407REGS.H"
.def _c_int0
text
_c_int0
CALL SYSINIT TR GHIR TR T
CALL SPL_INIT ;I SP1 WIURL TR T
LOOP: CALL SPI_SEND SR = A R
NOP
WAIT: LDP #DP_USER
SPLK  #00H, SPI_FLAG ;iiikri&
SPLK #00H, SPI_DATA  ;HEEHMH
B LOOP
0 () RGAVIARWIET
SYSINIT:
SETC INTM
CLRC  SXM
CLRC OVM
CLRC CNF
LDP  #0EOH

SPLK #81FEH,SCSR1 ;4 {545l CLKIN=6 M,CLKOUT=24 M
SPLK  #0E8h,WDCR ;X% 1
LDP #0

SPLK #0001h,IMR  flifE-pIbT 1

SPLK #OFFFFNhIFR i Wide

RET



. (3)  SPI WML

SPI_INIT:
LDP  #DP_PF2
LACL MCRB
OR #00014H CE SPISIMO 1 SPICLK 7 |k ik h fiE 77 5L,
SACL MCRB
LACL MCRC
AND  #OFFFEH JHC & 1OPEO 4 — LR 1/0 H1ThfE
SACL MCRC ;CS=I0PEO
LDP  #DP_PF1
SPLK #004FH,SPICCR ;Hii'& SPI 75 {7 a% SRV WAk, 16 A 20k
SPLK #0006H,SPICTL ; A1 J5 3, Il 3 TE LB I 1 B
SPLK #0002H,SPIBRR;SPI 4% % 2 6 MHz
SPLK #00CFh,SPICCR; ¥ Ua b 45 W, 56 AT IR AL AT REAT
LDP #DP_USER
SPLK #00H,SP1_DATA B R ISHARAIE
SPLK #00H,SPI_FLAG ;SPI_FLAG=0000H, #4417 = ffi i I
;SPI_FLAG=0001H, AT =i FB&
SPLK #DACOUT,SPI_CON;i% MAX5121 {4715
RET
; (4 T AR
SPI_SEND:
SPI_TX: LDP #DP_PF2
LACL  PEDATDIR
OR #0100H ;IOPEO JiI 24 iy th 77 20
AND #0FFFEH :CS= IOPE0=0
SACL  PEDATDIR
NOP
NOP
LDP #DP_USER
LACC SPI_DATA
AND #01FFEH :S0=0
OR SPI_CON
SACL  SPI_DATA RS AR R 3% 1 KA
LDP #DP_PF1
SACL  SPITXBUF B N B SPI R IE X
XMIT_RDY:
BIT SPISTS,BIT6 AR
BCND XMIT_RDY,NTC ;&i%5%
NOP
NOP
NOP

LDP #DP_PF2
LACL PEDATDIR



SPI_FALL:

SPI_RET: RET

—. KK

THEHLS SN T AT I BASHe 25 B AR O Bl A (RIS o J0AF AR ATy X T 43 JFAT
WAEFRATIAE PP BATIEAEISEI, eI, Bk,
AR WS BRSO, A 2R
T D& FRiE RS-232,

OR #0101H

SACL  PEDATDIR
LDP #DP_USER
BIT SPI_FLAG,BITO
BCND SPI_FALLTC
LDP #DP_USER
LACC SPI_DATA

AND #01FFEH

ADD #02H e 48
SACL  SPI_DATA
SUB #O1FFEH
BCND SPI_FALL,EQ

B SPI_TX

LDP #DP_USER

SPLK  #01, SPI_FLAG
LACC  SPI_DATA
AND #01FFEH

SUB #02H

SACL  SPI_DATA
BCND  SPI_RET,EQ

B SPI_TX

EH\

;CS=I0PEO=1

Bl A

A BT B

AT BB Y

Ul

HiATEEREDOESR (scD

TR MG, bRdES gafid. KO, AUd. igh.
A EFERIRRTT %, Hh 2 — A3 E
B HR S AT A ThREAR DS AR RIS .

RS-232 2 FRH 25 #H(W8EH 2% DB-25 5L 9 554638 DB-9, Hg— 4G5 015 5 e e An iy, Xf
FENE T 0 HS PR AR, RIS T A 7 e 2 I e AR AR B . JLBREAR M5 5 8 X

* 8.1 g,
% 8.1RS-232 #: 155 X
DB-25 J{ifi. | DB-9 M | 5 &fk | Jim X
2 3 TXD i K Rk i
3 2 RXD LITPN PGl
7 RTS it WRRIE (UL R AR IEE)
4 8 CTS LITPN k% (MODEM #E& #2058 )
5 6 DSR LEIPN i s UE A gk
6 5 SG — 554
7 1 DCD LITPN Hem B
8 4 DTR it Hn Zeomnk %t GHERD




20 9 RI LTI W2 i 7~
22 — — - {47 1
1

K2 AL F I e 4 A LA RS-232 B2 11, RSB ME B Fe AR SR ARARAF, ARILAE ) IZ I T SCRE AR AR
WA, PN E, RS-232 it HAtH X 3 M (TXD. RXD F1 SG) vl LI U7 4
Z TR AU (AR Kb

TMS320LF2407 P4 Hk SCI B, SCI BLUCR H & — R e druE S Seml LWL T 10, BIRFES
M e s AT A T2, A FES P 5 R 8 1 5 A AT B SR MG PR

TMS320LF2407 f¥) SCI HA7 A MF A fe )y, KRl s ae ) FEMHT 5 H e Pl R gcek DSP
REGUATREEAE, A5 A8 ) W) F 2 T4 DSP HLEs R I A AT e

SCI A BAE X =Fp TAE T AR5 b 7, AL IRRE 24507 sURPEXCC D Mgl 77 . 7€ DSP
ISR ) TF G R, g R BE D1y DSP 5 IS R S 24 LA I 2 e 1 S 1 2 1) b B R B BRARY (1)
FAFLIUE EH AR ? AL BA BRI ES ) Hhr. Ak, ASLIRFIA PC HUKEBH Ly, Zid
seb AT IR [ COM 5 TMS320LF2407 W5 Fr () HRATIBAE 1 1, REAT XU S 20 5 1 S o A48 1)
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—. EREM
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2. TREBRATRGMRCE, DMIEIESSIILE PCHL CEMHL MIEME.
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Ul
+5V
U2
1 C1 C3 R1
1 16 +bV
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RS-232 MAX232 = TMS320LF2407

8.1 TMS320LF2407 5 MAX232 #ZE %
1. ERSERFHL
CHEBEMT
#include "register.h"
int x,y,k=0;
static int receive[4],j=0;
/lconst int var[4]={0x12,0x23,0x34,0x45};
int var[4]={0x12,0x23,0x34,0x45};

void inline disable()



asm(" setc INTM™);
asm(" setc SXM™);

void inline enable()

{
asm(" clrc INTM");

main()

{
disable();
*IFR=0xFFFF;
*SCSR1=0x81FE;
*WDCR=0xES;
*SCICCR=0x7,;
*SCICTL1=0x13;
*SCICTL2=0x3;
*SCIHBAUD=0x1 ;
*SCILBAUD=0x38;
*SCICTL1=0x33;
*SCIPRI=0x60;
*MCRA=0x3;
*PADATDIR=0x100;
*IMR=0x10;
enable();
*SCITXBUF=0x55;
while(1)

void UartSent()

{
static int i=0,m;
if(i>3)
return;
*SCITXBUF=var[i++];
*IFR=0x0010;

enable();

void UartRec()
{



receive[j++]=*SCIRXBUF;
if(j>9)

i=0;

*|FR=0x0010;

enable();

void interrupt uarttr()

{
switch(*PVIR)
{
case 6:UartRec();
case 7:UartSent();
}

}

void interrupt nothing()

{
return;

}
BT EA
SCI_FLAG .usect ".data0",1 ;SCI bR &7 A7 8
TXD_PTR .usect ".data0",8 s R AL A TS X
RXD_PTR .usect ".data0",8 TR R B A7 T X
N .set 8

include  "F2407REGS.H" s FH Sk S

.def _c_int0

) TP ) R

sect " vectors" s SO ) B
RSVECT B _c_int0 :PM O AV i)
INT1 B GISR1 PM 2 T 1
INT2 B PHANTOM :PM 4 Ttk 2
INT3 B PHANTOM :PM 6 T 3
INT4 B PHANTOM :PM 8 P 4
INT5 B PHANTOM PMA kg 5
INT6 B PHANTOM PMC kg 6
RESERVED B PHANTOM ;PM E (TR E67)
SW_INT8 B PHANTOM PM 10 5 S AR
SW_INT9 B PHANTOM ;PM12  UserS/Wint -
SW_INT10 B PHANTOM ;PM 14  UserS/IWint -

© 00 N o o b~ -



SW_INT11 B PHANTOM ;PM 16 User S/IWint -
SW_INT12 B PHANTOM ;PM 18 User S/Wint -
SW_INT13 B PHANTOM ;PM 1A UserS/Wint -
SW_INT14 B PHANTOM ;PM1C UserS/Wint -
SW_INT15 B PHANTOM ;PM1E User S/Wint -
SW_INT16 B PHANTOM ;PM20 UserS/Wint -
TRAP B PHANTOM ;PM 22 Trap vector-
NMI B PHANTOM ;PM 24 Non maskable Int3
EMU_TRAP B PHANTOM ;PM26  Emulator Trap 2
SW_INT20 B PHANTOM ;PM28  UserS/Wint -
SW_INT21 B PHANTOM ;PM2A  UserS/Wint -
SW_INT22 B PHANTOM ;PM2C UserS/Wint -
SW_INT23 B PHANTOM ;PM2E UserS/Wint -
SW_INT24 B PHANTOM ;PM30 UserS/Wint -
SW_INT25 B PHANTOM ;PM32  UserS/Wint -
SW_INT26 B PHANTOM ;PM34 UserS/Wint -
SW_INT27 B PHANTOM ;PM36 UserS/Wint -
SW_INT28 B PHANTOM ;PM38 UserS/Wint -
SW_INT29 B PHANTOM ;PM3A UserS/Wint -
SW_INT30 B PHANTOM ;PM3C UserS/Wint -
SW_INT31 B PHANTOM PM3E /Ul —
JFR BT 1) B N D SE X pvecs

sect " pvecs" i S Il = B
PVECTORS B PHANTOM SR B 7] e MUk {2 5 0000h

B PHANTOM SPR B 7] e M hE {5 0001h

B PHANTOM SPR B 18] e bk (w2 5 0002h

B PHANTOM SPR B 7] e Mk {2 5 0003h

B PHANTOM PR 1) R HE R RS = 0004h ADC He i

B PHANTOM SR 1) £ ki #% & 0005h

B SCI_RX_ISR R i) S B RS B 0006h SCI 4224

B PHANTOM SR 1) b % & 0007h

B PHANTOM R U2 BEen 01 R (2 A

B PHANTOM R U2 B 01 R (2 A

B PHANTOM s R ) E kR RS 2 -0a

B PHANTOM o R B 1) Sk f RS

B PHANTOM R e BEen 01 | R (2 A

B PHANTOM o R B 1) Sk f RS

B PHANTOM R e H T B 01 R (2 A

B PHANTOM R s A T BEen 01 R (2 A

B PHANTOM s R 1) Sl s - 10

B PHANTOM s PR ) b (RS

B PHANTOM s PR P ) b (RS

B PHANTOM s PR ) b (RS

B PHANTOM s PR ) b (RS



T W 0 0 @ W 0 @ @ 0 ® @ W 0 W W 0 0 @ W 0 W W 0 W W W W WO O T® WO T® ® WO O T OO TT®T

PHANTOM s R ) b (W S - 15

PHANTOM R Rl B 01 | R (2 A
PHANTOM s R B 1) Sk fn RS
PHANTOM R =2 B 01 R (2 A
PHANTOM s AR ) Rk R RS -1
PHANTOM R R B 01 R (2 A
PHANTOM R R B 01 R (2 A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM i PR ) ik A% 20
PHANTOM o AR A B A
PHANTOM o AR A B A
PHANTOM R R B 01 R (2 A
PHANTOM o R B 1) Sk f RS
PHANTOM i PRE )bk A% B -25
PHANTOM o AR ) B A
PHANTOM i DREY ) sl (R A% 5-0027 TIPINT
PHANTOM o AR ) B A
PHANTOM s DR B 1) Sk f RS
PHANTOM s R ) Rk R RS & -2a
PHANTOM s PR R S
PHANTOM s PR 1 R A
PHANTOM s PR 1 R S
PHANTOM s PR 1 R S
PHANTOM s R LS & 0x02f - T3PINT
PHANTOM o R B 1) Sk g A% 430
PHANTOM R U2 BEen 01 R (2 A
PHANTOM o DR B 1) Sk f RS
PHANTOM R s BEen 01 R (2 A
PHANTOM ; 1mEE|nJﬁﬂﬁtlHﬁ$Z%
PHANTOM s R ) kR RS -3
PHANTOM ; 1m%|n1ﬁi@inzfﬁ$2%
PHANTOM s PR ) b (RS R
PHANTOM o AR ) B A
PHANTOM R Rl B 01 R (2 A
PHANTOM s R 1 Rk R RS 2 -3a
PHANTOM o R B 1) Sk fR RS
PHANTOM o R B 1) Sk fR RS
PHANTOM o R B 1) Sk f RS
PHANTOM ;AR A B A
PHANTOM i PR E ) e bk RS -3
PHANTOM :CANMBX_ISR; {3 B4 [t My b (i 7% 1t

PHANTOM R 1) B R AL B 0041h



; (2) FREFP:
text
_c_int0
SETC
CLRC
CLRC
CLRC
LDP
SPLK
SPLK
CALL
LDP
SPLK
TXD_LOOP:
LDP
BIT

BCND

TXD_DATA:
MAR
LAR
ADRK
MAR
LACC
CMPR
BCND
MAR
SACL
XMIT_RDY:
LDP
BIT
BCND
B
TXD_DATA_END:
MAR
LAR
LDP
SPLK
WAIT: NOP
B

INTM

SXM

OVM

CNF

#OEOH
#81FEH,SCSR1
#0E8h,WDCR
SCI_INIT

#5H
#00H,SCI_FLAG

#5H
SCI_FLAGBITO

TXD_DATA,TC
WAIT

*,AR0
ARO#TXD_PTR
#N+1

*,AR4

*+

00

:CLKIN=6 M,CLKOUT=24 M
SR T T
AR A g

A ROE A AR AL

: SCI_FLAG.0=1 I &3 ¥4

% N A K R

RI%E N ASHR

RER 8/

TXD_DATA_END,TC; JI¥#s K i%5¢?

*,AR2
*AR4

#DP_PF1
SCICTL2,BIT?
XMIT_RDY,NTC
TXD_DATA

*,AR4
AR4#TXD_PTR
#5H
#00H,SCI_FLAG

TXD_LOOP

; (3) BT E YIRS

SCI_INIT
LDP

#OE1H

HE SCITXBUF %5 177%

KA ROGE I H AR AR B

A RIL A AR AL



LACL  MCRA
OR #03H
SACL MCRA ECE SR AT LSRR DR TXD. RXD
LDP #DP_PF1
SPLK #000FH,SCICCR b LA I BRAS 2,8 A7 i dE,
NI VACRIR A o 1
SPLK  #0007H,SCICTL1  ;#lr. Kik. AHEENEMlifE SLEEP=1
SPLK  #0002H,SCICTL2 b iffife
SPLK  #0001H,SCIHBAUD
SPLK  #0038H,SCILBAUD ;J%4% % 9600
SPLK #0027H,SCICTLL ;& O#IMHIL K
SPLK  #00H,SCIPRI
LAR ARL#SCIRXBUF #2028 % 17 #s Hhtik
LAR AR2#SCITXBUF  ;RIEZEM & A7 2 bk
LAR AR3#RXD_PTR AR BAR R
LAR AR4#TXD_PTR SRIR R TR B

LDP #0
SPLK  #0001h,IMR FOVF INTL Hh iy
SPLK #OFFFFh,IFR RV RER Ml Y S
CLRC  INTM PAFSER
RET

(4 R

GISR1: SEg INTL ik AL

R

LDP #0  IRAEHLAS BN
SST #0, st0_temp ; il A 3hS-4k DP-0
SST #1, st1_temp ) RAPIRE A /7553 B2 DARAM.
SACL  context ; R47 ACC I 16 7
SACH  context+1 . {47 ACC )75 16 £i7
SAR AR1,context+2
SAR AR2,context+3
SAR AR3,context+4
SAR AR4, context+5
SAR AR5, context+6

LDP #OEOH

LACC  PIVR/1 MR PR ) R A A2 (PIVR) JEAB—(
ADD #PVECTORS SNBSS
BACC S 6 BUAH R 1) T T IR 2% 1 R

SCI_RX_ISR: M T R 25 R

LDP #DP_PF1
MAR *,AR1
BIT SCICTL1,BIT2



BCND  RXD _DATANTC  :SLEEP=0 424

LACC = LA

SUB #0AAH

BCND  TXD_FLAGEQ BN HhE A AAH, IR % 44
SUB #0001H

BCND  SCI_RX_END,NEQ ;#tuhil-4fi% it

SPLK  #0033H,SCICTL1  ;#ilil:y ABH, Ui SLEEP=0

A HE SRR
B SCI_RX_END

TXD_FLAG: R IERRE
LDP #5H
SPLK  #01H,SCI_FLAG
B SCI_RX_END

RXD_DATA: N A Hdl
LACC  *AR3 RSN &1
SACL  *+AR0 SIRAT AR
LAR ARO#RXD_PTR
ADRK  #N
MAR * AR3
CMPR 00

BCND  SCI_RX_END,NTC 24l se

LAR AR3#RXD_PTR RSB AR TR #RX_PTR

SPLK #0037H,SCICTL1 ;¥ SLEEP=1 F/ngalioiht
SCI_RX_END: ; op TR ]

B

LDP #DP_EVA

SPLK  #OFFFFH,EVAIFRA

LDP #0

LAR AR5, context+6

LAR AR4,context+5

LAR AR3,context+4

LAR AR2,context+3

LAR AR1,context+2

LACC context+1,16

ADDS context

LST #1, stl_temp

LST #0, stO_temp

CLRC  INTM T A e T BRT DAy — 3 e
HEEIPRE RSO i

RET
i (5) PR
PHANTOM

KICK_DOG BT

RET



END
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ﬁlﬁﬁﬁﬂ,ﬂuﬂﬁﬁﬁﬁmﬁﬁmo

(2) ESFEF R ah bk

FESERRFE P RIS, A I T 2SS TR P I aa bk, 3T DLAE S g B 11 S8
B TR

o E SO G T R R R I M hE g, XS g — AN W R 5.13 B “ View
Address” (Sl gt a0 X EHE

@ Diz—Azzenbly r. ”'|:| |[5_(|

oooo 5cCscC :

0001 Csab MPY #8ahh —

oooZ 021a LAR &RZ,1ah

0003 8643 SA4AFR ARE, =+ AR0O

0oo4 4500 BIT Oh,5

0005 0080 LAR BRI, . ST

000e 70FS LTA *#*BRO+

0007 09AC I

ooos A901 BLDD 1h ,#5=fh

|_|<|_II_I.E-. II-I'?.E.I_I TAR ART %4 5 b 0K | Cancel |
P 512 S PiHE 5.13 S it dg b A8 O T AE

AERSTRHE TP A AT EE R e bl . P A oy DU — A8, bl —A4
CitimRIEA.

(3) FE SO Zm % 1 AR A BN s PRI A, ik s

7E DSP A ifilid fidy, S AE R E W & (breakpoints). %Wﬁ(mmﬂmmﬁ%
MEE D Rk s Cprofile point J AR 7> 45 89 55 75 2 RS 0, T8 I 3K BURe 7k (1) e nT A
m%%%%ﬁﬁﬁﬁﬁﬁﬁ,E%%%*@#ﬁ?#ﬁﬁ%@%o

FE SO G el AR ] DLSE BB a5y PRI s R i (1) 8 8 Bl B TR AR ik F

MR 25 g i, K “Debug” BRAE SRS “Profiler” SE 5irh G BEAH
NSRRI A

Froject Toolbar E

A2 I F O D@
< FIH I H 4 (project) R AE I (1260 58 %

W .

R BB WA GO R SAT, W EIZA TSI R, RN E .
(4) VB R4 v 1 XS 116 15

CC’C2000 H 7 JUFPAS [l (3 101, 8 3ok fff i I 46 16 10 ] AL S 314 i 11 i B AN [ 1)
5 RS T o S4Bl UG SO R HE AC VP i Nk 1A L e 00 R, 43 vy LI
PN B A SR . BEE RO R I ) T VAR




EFESE AT 4 “Option>Dis-Assembly Style” (BTN > il g A% ), B 1 SO 9
Fep s b, BB S, P A “Properties-> Dis-Assembly Options...”, i} ]
5.14 7R,

o BT RE IR ST G T 1 KUK B TR EAE , 306 B T 5 2 1) S 5, B 1) 5.15 Fros

IR AR TE R, S G T 11 LRI AR S P BT IR AR

(5) W% C IR 5L v IR & A ChY
FE it 1 H, CC’C2000 R3S fLVFXT C P4l NV P 0 Syl g st R . ol 2
A LA SR C R S g e it sl g — 1 — TR 2 45 3
TERE PR R H AR R el TLas i G, W% C 2P SR ARG I g I 7w F
BG4 “View>Mixed Source/ ASM” (L >),
BG4 “Debug>Go Main” CEi& > 123 Main).
X2, RGBT H PR, JEE “main()” AEESAT, FR, C RIS
P2 BoRTEgm B Hrh, P AT SRR PC RS THEED .

UeAk, IR DOE RS RS AR 4 o C IREY . kR kPt a4 “View”
>Mixed Source/ ASM” (R >, B fr g i 11 h Ao bR J5 , 7238 SO TEAE H 15 £ Mixed
Mode” 5% “Source Mode”.

jogon sose

N0l CEAA MPY #Bahl r . 1
0002 D21A LAR ARZ, lzh Diz—Azzembly S5tyle Options R
0003 BG6AA SAR BRE,®s ,ARD —
0004 4500 BIT Oh .5 .

0005 0080 LAR ARD, = MEYE Eadix

0006 70FS LTA _— )

0007 DBAC {* Hex i Decimal

00068 AS01 BLD
000~ D7AD LAF
0a0e FSha

000C ZE04 ADD
0000 D093 MEY
O00E 1754 LAC
000F 4435E BIT)
0010 DIZE MFY)
0011 4088 BIT
0012 3324 SUE
N013 DC4Z DL
0015 BARA POP
0016 E364 ADD

Start Rddrere

Paich Axzesbly

Bar T Coarsor

Togels brsakgaini
Teggls Egabs Feant
Teggle prafile point
ol Tatak

hdd te Eutch Tundew

Cloks

0017 eFng BrT ¥ Tlest In Bain Tindes

0018 ES45 [ACL

0019 EED4 RFT

45h
#4h

[ ;I-rl.

Feakn

Direct Addresszing Radix

{* Hex

i Decimal

Immediate Addressing Radix
{* Hex

i Decimal (" Binary

Cancel

P 5.14 BT E SR VB PR G HE
5. HAMSREND
5 UL 3 88 RGTT At FEAR ], A3 B B A7 A o B N 2% o 0 an e ) &
G R R A IR A, PR A B W B R A I A et B, DA A
FEIIERATE . CC?C2000 FF & S o R A7 it 2% T 11302 by itk H 1 i 15 1
(1) WEEA7Ai o N B AE
WA s WA B T E R

K 5.15

~HEFES I AT 4 “View>Memory” (4> 174 85), stk T iashpy B

Frfatl o BEITERAE 2 Ja 4 AN bt & 5.16 Frs i “Memory Window Options” (f74i 2%
BRI WHEHE . IXASKHEHE ] F SR PeAE A 28 5 P i AR 1
o ZERHTHE TR AN BT 7S S I AT

e I S = A N e Ol

DR SRR A L A7 it 1 11, 7T DUOE AR A7 Gl B 1 b A ol BUBR (K50 R Hh T



B, SRS ARSI FEAH N ) i & JE 1% “ Properties”, IXIN2x 3 41 B ] 5.16 JT s A7
i A TN U RE S E S A P i A A I PR 5 3 B AT 58 ol e 2

Nemory Window Options §|

Titl Memorv]
Address |0x0000
§-Value |0
Format |Hex - C Style ﬂ
[ Use IEEE Float
Paga: |I|ata ﬂ
[ Enable Beference Buffe
Start |
End |
n
0K | Concel | Help |

B 5.16 7k B T0 15 HE

W BE S AF i A rh SR Le s, T LAAEAP g 4 v 11 o0 00848 o8 kil AR5
SR T B . AT AR RS a4 “Edit>Memory-Edit” (%> 176k 5. Hihk?
=. TiHEEMgRmE

#£ CC’C2000 JFA-~ &, T Al C. C+-+Mas i gw 7 i 248,
I, RAT VC SEIARTHENUIRAT R G A 57, R R “IH 7. X Fp
THAEAAAT LAJT A 2 6 R G A FREAT R, TR PO R G A ) T S A R
HOTF I o X RRAT T 2 T5 305 7N RGE AT P BB T R 7 B A AN, AR B A )5 1 R
[Fi) o 3 EL AT R A ()35t A% N ARFAE
1. TIEEH

CC’C2000 FF A&V &0 F P RGeSAT I H & BE, A 7 22 40 (1) G il R R e 2 AR 74 1 o
] 7. CC’C2000 FF A& V- & & @ r AR P IRIB B S, 08 B AN R R
AT I B, R F R R B AR o fE— D00 H ol s an s A

o PACHL SO 44 R H BARHE ST

PERs TG A AR IE T

o AL R ST

J3)) CC’C2000 Ji&, 2 F3h s I H & BLE 1o a1 R 3¥a Won i H & BLE 11, o] LU
FZE a4 “View>Project” CWE>T0H ) ¥iG . w LAAE T 1 Rl ik A B i o SCPR45 2
TR 28 LR B [ E R bR il BEAN R R 0T

SR I H 4 B 1 0] DA 23 D7 (S8 R e B, I H A BT LT ] 5.7 P 7R
TiH A B b2 Bos I H SE R 2 T H 22 B0 DL 2 5 T H OGIERR Y o BT 1
mEﬁW%TuEﬁEEE@D¢mﬁ [FIB, fT-76 CC’C2000 T H 4% B i it 7 AH 4 1)
BefEdn A, KM & TP RGEMIFRESE . BN, EPR—AN i 5 AR 7 4R
FURGE, WA — R B T R i — AR, R IH A B Ay A U A
SRR P AT B g 106, T AN BT (PR e A A T H 3 i 1
2. MEEHEF MR

T H A FE D L, — G SRS UL (File View), ) — U245 11 (Bookmark) .
(1) ST EETT



SIS T R 55— AN Sk )& GEL— —General Extension Language SC#F3¢. GEL J&
—FERE TR NE S, AT LAk S A SR BOT K IE IDE F7 ] H bR A6l 43 1508 1 1)
RERKEL. 7 CC'C2000 1, GEL SCAF FHRAE ORI R A7 7 B B B R T A A58, 49 T i 11 ) A7
B ASFTITE O, TR ES.

SCAE SR GO R B 5 — AN NI E P (0 I SO R SO AE— AN E 3
PERE 3 BOUAAS R P FEREATA B, Wb &) 5.7 Fs .

*Include (37 ): Include "4 47 Lh.h 94 J@ 44 B SO CRIY C B 35 S 1 Sk S04

*Libraries (J£): Libraries A28 T T LL.lib 94 & 44 1 22 SCA

*Source (J5): Source L7 T A LA.C Fi*.asm A4 @44 i SC A

R R IR Ay 2 S (A .omd) & BB B RAETH SCF R o T0H SCAFZ2IH 1)
EHCE, Plmak AT RS

— H DG 7 I H , SRR SO DR Y 5 R e I S I A L SO X
H AR bR 8RR E SO “+7 £f55, LT RR AL A R, WoRts s cft. AR I H
L R SO R VA A B ] 5.18 o, BARDT RN

& Files
+-_7] GEL files
=1-2] Project
= ﬁ syl mak
£2407. cmd
=27 Include
F240TREGS. H T
wvector. h 4 () GAL Exlas
. . B Frajact
=[] Libraries _-lﬁm]],"mm_:
rtszfxx. 1ib j,_ Sowm Al Dagardduncias
= g5 Muild
our e T T
5}'1 asm :'E.pl.um
Kids
# Flaat In Buin Findow
B 5.07 I H B L PP 5.8 SCPFR AL R

BRI — AN H ScE, T RbRAT S “Project”, WoR NI B 5.19 FTs KEAISE
M, EFILA R “Open project”, FRARHEZS T “Project Open” X UEHEFT T T 75 2 1 S04

PG AR— AN SO SCIE, T bR A s “Project” AL I SCAR SO, o HE it
Kl 5.20 TR sE 0, VeI “Open” fird o IXINHE TAE S 4 B S
T, ] AT SO w4 7o Bhah, 38 mT DA AR ELEE N SCA A, RIAT 4T I e
AR

 FEXSAN IR SCAF BB G BEIR N, W] LAYER ] 5.20 H £ “File Specific Options”, iX
I 2B an b 5.21 FroR IR gm PR SE TR HE . AT DARR 3 75 B PEXRHEAE (240, fe)m o

S I T

T PE—ANSCME, I EUAR A B I SE I SO, o HE B I 5.20 BROR IR SR IR
fELhikEE “Compile file”.

SN AR E , RS BT e “Project” SO, o WP 5.22
FoRi SR e, Rk R “Build” BRI 5E R

< TENIH R E—AN SO, T RUbRAG B ik @ i S0, o il 5.16 BRIt
S, R kS “Remove from project”.



mann

- . ::. hid Frlsc ;
% Disn ¥ Gewn K1 Bapandancuan '
Cmmpala filas i Medld :l
Emmove from poaject | Clocs i]
e . ¢
i -'l-'“ o n i ;;l.i- Speai Buo Opid e (piiana ;
epsrEasE
.-‘E' Bl Dackng W M0 el i
¥ AlLow Tocki f
Kada _— = s
Floal T i Findis Fleat In Hain Tinder Meut In Baaa Fioder
W 519 BRI R 520 ORI HHEE 522 I L
Build Options for syl. asm [$_<|
Azzembler l

= v
| Suppress Bammer [-q]

Targzet Processor Cexx [-+Pxx] "’l

Include Search Path [-i] |
[ Enable Sowrce Level Debugging (wer B.83 or later) [-g]

Define Symbols [-d] |

Insert . copy File [~he] |
Inzert . include File [-hi] |
[ Generate Listing Files [-1]

| Generate Cross—reference Tables [-x]
[ Malke Symbols Caze Insensitiwe [—c]
[w Male #11 Zymbols Flaobal [-=]

[~ Detect Fipeline Comflicts [-w]

Port CEZX code to Hone -

fiR=E HRiH #EEh

BHE 5.21 G BEIE TIN5 HE
(2) B
PE G WoR T SO aE, DA B R P A SRR, 58 v A T DA e T L
G TR 5.23 o, Hoh 5 dn AL Dy Rean

Edit Toolbar 1%
WEAE|ECE EE AR WS

MR 5.23 g T HAE:

=
T EEERRE, LF ARSI S I
+[§
T GRTFAAIES (B, WREREI T, R S T . R

Azt 2, AT LB R PTAR L ST KR R ),



— R B BT 4 S
S P A o EIN N E LR
— — JE R S e IR
— — LB L TN AL

“‘——Ei#@ﬂ*%ﬁ%%%%ﬁi&ﬁﬁﬁ%%ﬁ,WW%E%%%%MW%
1%, WERBA BENBE L,

p
— —EH A AP AR A A

)

A S e A A1
N L
3. WEHE

A ORI H A B AE B ARAE AT Lhomak A YT 4 I H SCE . AEET T RS R
AT LG Ik AR B @B I H A B, BT I CAFAE I I H 5 B A
(L I EAHIH

B AN ESAAERNIHE, 7] LLEFSE a4 “Project™>0pen” (IiH >$TFF),
SCPFIERE OO UGHE, X B AT DO B SO T AE I SCAEIE, T e 3 B LA A7 AR R I H 45 B S0
WA DU AT R0 50 H A B TP — AN CEAFAE I H
(2) FrFH

FETFROBI N FH R GE, ZE S I H o BRI vk

EPER AT A “Project™>New” (IUH >Frg), 7EHH 1SR TG HE Fh o $5 2R
AT H ST SR, BT H SO, B “ORAE7 B . R i TSR I H A8 98
ALK C TSSO RAR IR, T DA i A AT H e R — AN S0, DA [ 5 H
X5 TF.

AR H LG I, AT DASSE EENT I H DRI H BT YRS H AR SO A
DINZIIH A BESC A B N SO
(3) R IEAEEAE I H

W R BR O BT E R ERAE I, W) SRR A B I H L
“Project”, 7F 7~ HIFAH S B rh i $E “ Close ” T, i) LA 564 “Project™>Close”.
I9. CPU & {rafiRfE

e CPU I RGTIT AR FE T, BZEXT CPU Bl DSP 1) N %5 A7 #3047 EL#E 1
B (UMESILA S, IEFEACAT DI P R P A7 0 Bik, o mr DUGH A P R4 H A &R
GEINREHEAT o PR, P R TT A ) — P R . LRI R AR, 7F CC’C2000
FERAEG R, $RAE T AR DTS H AR R 40 DSP #8111 CPU Z A28 FIAM B a7 474,
] DUTE I G 4 2 A7 AR T DU H AR R G0 DSP S 75 A7 2% (1) 8 28304 T S 24
1. WEFHENE

BTG H bR R4 DSP #1 CPU T3 /748 I 2%, mTLARIBLU R A ik —iiH CPU %
T s



B A4 “View>CPU Registers™>CPU Registers” (W £¢>CPU % {745 >CPU %
)

A T AR e B .

7t CC’C2000 Ft1fiit CPU Ff e iy & 4 i 1¥] 5.24 i
2. AR TIAE

U AT AT A, BT T g R 25 A7 2 e o AT DUF DA R =R 7k 2 — 58 g B 2 17 2
XoF 1 AE R A -

RS HL A “Edit>Edit Register” (Yafi >R 7 Aras), LG 75 A7 2 5 U AE f
AT %%

AL A AT T O AT 4, IR AT A7 A T S AT Y

SRR AFA T A o bR, EIESER R Tk P gn iR A AF A a2 “Edit Register”, I
S A7 A UG AE J AT G R

i 2 AT B XU HE W BRI 5.25 BT o gt 25 7w xR HE B AL 1 R 36 700 -

PC = 0028 AR0 = 0072 I~
A0C0 = 044373F9 ARl = 1EZ3 I
PEEG = FFFFERODZ ARZ = FFFE GE
TREG = FFFE A&R3 = FFG1
STO = 2600 AR4 = 488D _
&5T1 = 25FC AR5 = BEFE w
< 3 [ close | Help |
M 5.24 FFA7A R P 5.25  giE a7 47 g5 X TG AE

*Register (A7 fras): ARG NG 40, BOH AR N hr e b e S 2 g iR (10 27 47
o

*Value (HfH): FEG 2T A7 S AT IERE A LA/ 8E ) Chex) [B7isii s Ar A7 4 9 1 AT i
AR B AR (i U AT TSR Ox BTN EIED, W Bl C ik,

s s, sk <L Close b s pama s, i AT AR

T H A7 FLAS T AN P A7 2%
Ti. F# COFF X
EIAR DSP ARG B A AT R B rh, A — R EEEOR A “ o Bt 4
Ao 53 BOASHR M & 2 - W SR PP BB AR TS e 7E H bR A il b o 4l — AN ERZ 10 bk 2 )
FREBE T FTRCE SR b b, SRR B AR Al o> B
H AT W, 73 BORBTHR SRR R AR T A E R MBI EOR. (B s, 78l
A I 7 T, 4 BOBTHEOR AT H8 A T 180 B2 1R R D2
Eﬁﬁﬁ&ﬁ&%%ﬁ?ﬁﬁﬁ,%ﬁ%cm¢i#%ﬁoawF%#$aﬁi#%ﬁ
[)5% 3¢ Common Object File Format [455, J&— M SRR 7 BoB Bl 18 7 (1) — 31 S
PER$ o BT 11 COFF 23 BOSTHRHT ] LU B AT B AE A e b, FH P i) DAAEAT A — AN 40 B
B BCE AEAT s AT L
1. i COFF U EFE B Fnii H BI3R4E
(1) M4 “File>Load Program” (3CF>3e8F2)7), FTIF Wik 5.26 iz “Load
Program” (F&/7¢80) RHHHE



Load Program E]

HHEE 1) |lf}wnrk ﬂ EF '
] ¥ REALTINE
HEITANI
€
£
AT
HAIRE
P L S5
I ] | e |
IoiER (T |* out (Coff) ﬂ i
FEBD (10

FHE 5.26  FEJPEEHNTTHHE

(2) ZERHEHE “Load Program” i, EREFFETRCHE, Rt L TFOQ |
S RER T AT 6 2 O RIS 1 COFF ORI 5 K Bt F R Rt

4. WEBFREETRE

e H a4 “Options>Program Load” CGEII >FEFPds#d), n LIk & 53 %
) — BRI, X I T .

*Perform verification after Program Load (F2)7$¢38 )5 1 RE30 UF ) = 45 44 T, CC*C2000
SR EIXAREHE, H RS HA R IR IEM C R . A R OCPIXANE D, U] CC*C2000 #
ANFX R R P AT IE R A A o A X AN 00 AT UORIE R P g 1L ke 2k, (HX—2eLbig
KRR, T ZHATHAS A, I AR BRI e 1)

*Load Program After Build (@538 7). WA A T axX ANk i 5 @ 1t H A4 G
AT HATFE P BRI dk . X ] DUGRAE H bR b3 5 b B A 0 H B T b e B 0 755 15
He
N. BFFEiTiRE

1. CC*C2000 1, #2472 Ml A e IRas AT B 7k IR VA LA TR 1
J5 AL AR T HAL . IR T E R QB 5.28 FraR . A v] LLAE R 5 “ Debug ”
HOAH Y 1) A 2 4 R P AT .

Debug Toolhar E|

BTy 2R s HEEREE]

I 5.28 IR T HA

1. BPPATERAE



FE TR Rt AN AL, AT LSS0 R A

o
(1 stepinto CEBHAT): TR RS, AT LU TRA L S A TR, B
RN, T UASE R 4GS A AT . JeAh, AT LU R 44 “Debug
>Step Into”  SEAH FIGERNE . WA C BUFARAD, WX dr BT — 4% C 45

4

(2> Wstep Over CRAMAT): HAMATHOR B AR H— PRI IER L, AEHIT—

Fel— B . 0, X BRIRE PR, E— YRS RAT I R AT — SR P R4 (
AR A B C D . WERPT AT R R A, WA AT A & AESRAT 58 BT
PR Je AR 8], WA ET A R — 5582 S8 e 102 5 b AT IR 1
WA o B PAT iy STEPATTEF IR I, AR HAT 58— S48 2 T EE 1 G
P EIRESF ), T ASEIE IR AR R — S48 2 4hdT

-
3> Wistep out (ki TRUF): X &AA T TR IR T . ERRdmy, 4
2 A A TR TR o 4T B TR — 3B, T RS A 2600 1% TR 30
ONEEEATREOL, I ET LA Tk TR A4, A R [ B % TR R L
BRI AFHTRIF G S84, ELRR [ FE % TRIF I 4. Heah, BT LUE i Pt
Hifir A “Debug> Step Out” 5 HH A (R HRAE .

(4> "B Runto Cursor (HUTEDHR): ZEBRIEEL 1, BUTEIEER ir % AT ISR -4 )7 (8
MRARRRE P s, HBAEIR A O i B — b GRUERZIR 2 TTEAT),  HinT LUNFRF
AT AL B — BT B S 2 v 1 AR T e

ek, 3R] DA e B SE I — MR E S I E S AR, RARRRAE R

S EFESE AT 4 “Debug>Multiple Operations” X >#A/E¥E), X< —/M
B4 1&] 5.29 T/t “Multiple Operations” (GHRYEE ) FHHE, ;

A B R T T R T

«Count (I#0): ¥ B AHMN FIHRAE KB

. i “
2. BFHIERIEAT
WRFTFE R A PATZ 5452, SRR A T e SEBirks (hg——%
M AT, AT LR B P sE B AT i 4
(1) 2 Run GafTREP): XAA IR, MUREEFRE (PC) Frieiifi & LI
HESPATREY, EREE]— W5 s B IAFE 85 dOh 1B A REfs 108 4T o X FRIE 4T 77 2 nT LA
R A A S B TAER (IO R 18T o B 1A R T H A T i A4l 4, 18 v] LU
WEHESE AT 4 “Debug>Run”  5¢ A A A .
(2) = Halt (45 1) s 3X A4 R U IEAE AT IR o AR nT DU i e 53¢ i 4 “ Debug
>Halt” 56 A A 44 «

3 2 Animate (B : X2 MEWRUSCRE N IR P K62 o BT %62



e E AR, RS, RS — T 2 P, s U HTRE AL E AT B BT s 21
F— AW 2, AREHUBNE S PAT B AW TR RS, W i I
S — AN o PAT BT — AN S R 2R, A0SR AL s L, R A R R R AN E
Wi i — HPAT T 25, Ref i L SRR A G WP AN EZM?JH}M?, D25 A
Jil “Debug>Halt” &£ -2 P HIHAT, RPN 3=, T DU Rk
fir4 “Debug> Animate” 5¢ i A AR A o

B (P PAT 345 T DAIE O e B R IO AT R . B I A R PSR B 4 “ Option >
Animate Speed” (LI >ZfmAE ), X<t —N Wikt &l 5.30 i) “Animate Speed
Prope...” (B W E) STUGHE,

Hultiple Operation g| Animate Speed Prope... E|
[Step Ints ~] 0K | Animate Speed (0-9 a _|:i'
Count: _|:;| Cancel Cancel | el s |
B 5.29  #RAEBCE X IRHE Bt 5.30 i o3 152 KT A

X S 7% E e N SRR (B, B skl AL, nT LA SE s e 5
I

(4) Run Free (HMIZ T): X2 —F&2MPATH B REEa4, S8IrBra2 A6
()52, H HIEAT 4 20 DA I s, MY HT P R PSR BT D4R 070 B T 4R Al AT FH R
%?ﬁkﬁﬁ"i‘ﬁ%?ﬁﬁﬁ’v\ MR PES H 4 “Debug>Run Free” HIT]. HfEAiH] “Debug>
Halt” iy 245 LRI B iz A7 . WA 2R A ITAG #4854 PC MLFIIF R R4,
WIFE H Iz AT I PC AL R R G0 AN AT AR 4%
+. HERARKERFIE
1. X BB R A7

FEV, AT S DSP @A T HEAT AR . XA ERAE T LAl CC?C2000 SEHL. 7E
CC’C2000 et 7 —4845 % HAR R4t DSP @I R AL A4 .

(1) Reset DSP (DSP 54 ): EF=KHdr4 “Debug>Reset” (i >DSP &A1), nJLL5E
Jont DSP S A #e4E, Al H AR R 48 DSP #AHk E 2) Eryaskas, JF HZ& R arsir i
FUREY o R A R S T AR IR SN2, JF H B ASBO A7 dr 25 Y, ) DSP
() A% S AR, X A2 B P A T A R e 3o

(2) Load Kernel (RE#HWIZ): HIRTWZKIAR ARG, WIS ERENITTERSS
PC HLZ I HEAEAESS . W AT A EE T ITAG A, 12T WM R
g8, WY N AZRE A G # A IR 3N ek 5 B Aras A 2 R TIEAE, TR RGEWBICIEE R TAE
T o X, BRI IS A4S “Debug>Load Kernel” Gt > a8 N A%, k18] TR b
FER N AL ALY LA IE (1) T AR A .

(3) Restart (30D X &AMl CC’C2000 FLFFa 4K 2 RPN i a4 o
W kP4 “Debug>Restart command” G > B B30, A LR FFRET PC 1k
SHHAPREFPRIND, HIFRPITEF .

(4) Go Main &R F| main): X &M T C &5 H )RR P I 1 4. i E P a4

“Debug>Go Main” Gk >4 %] main), CC’C2000 11— i 1 o hir o5 ¥ & A RE
JPORBET “main” HIALE b, FHMIFIEHATH PR, —ERE S| —ANH ) 35CE W Risk
PAT “main()” A A BT, AR, HARCRTIG T AL A SRR AT A 1R A



“main()”, ARG IR SR B F ) 2 802 CCTC2000 .
5. RIB&EH

FEPTE TR, AT o 1 op B A0 H AR R G i RPIRAS s (R0 SR o DA AR
W RE “Probe Point” b, TR 1o i 5 sh v] B AN 2 ol At (DRI h AN e B it 1 A2
AR o T REUER BIEOR I RGUIRAS, L 2000 B FLEAT Rl BT

FollET o v RAR R o, LB PR Ly & “Windows > Refresh” C&f 1> Rill#i), RIHAT
LSS T FRIHT, 3 IR el 0 5 20 PR 2 B AT IR A 2 I8 B AR RGP RRAS
7. RAFAVIR R BAE S H

R P AEERAE R 25 CC*C2000 11 # 4F FL IHTEATAH MY IR i 28, DU RS RIS OB A
H O AL E b ME R — O R TAERE, S SRR Y ar ) St g5k CLAES D
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